2.6.2.3 User’s Guide for Computer-Aided Planning

INTRODUCTION

The PW4SP Data Management User's Guide explains the procedure of encoding data and

generating tables and figures for the PWASP. The Guide consists of the following sections.

Sectian 2: hardware and software required to successfutly run the PW4SP Data
Management System

Section 3: the concept of the microcamputer architecture and an overview of hardware
configurations

Section 4: fundamentals to operate the system with internal architecture
Section 5: basic concepl of sofware operation

Section 6: a complele list of data files and workshects in the PW4SP Data Management
System

Section 7: data linkages
Section 8: the procedure of updating the P\WV4SP

Section 9: standard report format

SYSTEM REQUIREMENTS

The following are the basic requirement to siccessfully run the PW4SP data management, -

- Hardware: _ ~ Software:
Computer: 80486 CPU at 66 MHz. - Operating Systen: “ DOS Ver. 6.22
RAM: 8 MB {minimum) _ Windows Environment: MS-Window Ver 3.1
Hard Disk: 200 MB (minimum?} Spreadsheet: MS-Excel Ver 5.0

- Floppy Drive: 1.5 inch, High Density . Word Processing:  © MS-Word Ver 6.0

© 5.25 inch, High Density

Monitor: = VGA Monitor

Printer; ~ * $0column

(Can handic A4 size paper).

Mouse: Any brand which supported

by MS-Windows

Miscellancous: 500 waits Aulomalic Vollage

Regulater and Surge Protecior
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MICROCOMPUTER SYSTEM

All computers, whether large or small, basically operate on the same fundamental principles.
The hardware and software of a mainframe computer and a microcomputer have the same

components and fulfill the basic furictions necessary 10 any coniputer systen.

The computer is seen as a powerful tool that can enable us to expand the horizons of our

knowledge. It allows processing of large volume of data or complex pattern of information

that would otherwise be difficult to organize and understand. Moreover, it allows for an

easily manipulation of data.

‘There are two major comiponents of a microcomputer: the hardware and the software. These

two components complement each other in arder to fulfill their basic function.

A microcomputer hardware is made up of several components based on the functions they

peeform in the system and how they interact with the other components.

The principal elements of a computer system are:

» Central Processing Unit (CPU)

Main Memory (RAM)

Secondary Storage Devices (disk, drives, magnetic tapes, etc.)
[nput/Output Bevices (terminals, printers, elc.)

*» * @

" The CPU does the actual computing. - It is capable of simple arithmetic z_z'nd logical

operations, such as addition and data comparison, that are executed at excéedingly high
speed. The power of & computer directly stems from the speed and accuracy with "which the
CPU can carry out computations and move information around. The main memory of the
computer is usually referred Lo as Random Access Memery or RAM. ~This part of the
computer contains the progaams and information that are currently being processed by the
CPU. Secondary storage devices, such as niagnetic disk, is capable of holding large amount

of data. Programs and data are normaily stored on these secondary devices and could he

" retrieved when needed. They are then loaded into the RAM and executed. The results of the

processing can then be written into the secﬁndary storage device or sent to an output device
such as the nionilor or printer. Peripheral devices or Input/Ouiput (1/O} devices allow the
user to put data into a computer of receive output from a computer. A terminal is a
peripheral that contains both a keyboard for input and a monitor for output.  Other

peripherals inclade printers and plotters.
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'The diagram below presents the basic hardware component of a microcomputer system.

> Ceatral Processing Unit 4 o

(CPU)
IO Terminal I Secondary Storage
A . ) ?
Random Access Memaory
Keyboard (RAM)
g Hard Disk
Monilor  jage
@] Floppy Drive
Printer | g

Fioppy Drive is the most common lype secondary storage used in personal computer léday.
It-acts as an extemal drive from which the users inserl the ﬂoppy disk to store and retrieve
information. -The floppy d.isk conies in three sizes: 3.5 inches, 5,25 inches and 8 inches. It is
characterized by thin circular plalstic she_e_té coated with iron oxide so that magnetic pattems
recorded on it can be retained. The surface is similar to a magnetic tape used to record
music. "The disk is contained in'a square cardboard envelope in which it spins. The 3.5
inches diskette is contained in a hard plastic case with a metal shutter that protects the
magnetic media.” A floppy disk can store from 80 kifob_ylcs to 1.44 megabytes 6f data.
Floppy disk system is slower and has less storage capacity than hard disk system, but its

lower cost makes it a popular choice for personal comyputer.

Hard disk is made of magnclié metal, and can either be removable dr non-removable. The
most common type of hard disk found in personal computer today is non-removable. * This
disk typically holds from 10 megabytes to 1.5 gigabytes of information. Each megabyte is
6quiva!ent to 1,048,576 éharacl’cr@ of information, or roughly [,800 single-spaced typewritten

pages; hence, this is a very cfficient way to store large volume of information.

Keyboard is an external device that acts as a primary interface between the human operator
and the computer. The keyboard has 3 basic components: the Lypewriter keyboard which is
composed of alphabet characters: the calculator pad which is composed of numeric

characters; and the function keys which serve as special macro key for various softwares.
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Manitor is the screen or video display peripheral and serves as the main output device on a
= personal computer. It is used to display text and graphics information and is available in a
variety of sizes and types. Monitors can be divided into two broad groups: those designed to
display text information; and those designed to display graphics information. such as charts
or picture. Within the graphics group, there are color or monochrome (single color) displays.
A high quality graphic color monitor is capable of showing high resolution palttern and s

recommended for application in MS-Window, Excel, or AutoCAD.

Printer is another common peripheral found in personal computer system. The 2 common
type of printers are dot matrix and laser printer. The dot matrix printer produces its image by
printing a group of dots that forms the image of a character or symbol. Several methods are
used to create the pattern of dots. The most common are impact, thesmal, and ink-jet
technologies. The laset printer produces its image by means of electrophotograph simifar to

the principle of photocopy machine.

4.  OPERATING SYSTEM

iv o An operating systém is a set of control progrmﬁ that :ﬁanagcs the computer’s resotrces and
create a well-defined software environment for computer applications. Cﬂmpulér hardware
by itself can perform little useful work.. A computer requires a software lo be able to
‘communicate and do .useful work. ‘The first fayer of software in a computer system is the
operating system. This is what starts, or boots up, the machine helps in pulling itsell up by
its own boolstraps and ¢sfablishes a predetermined set of conditions so that 'applic;uibns can
be min. When the computer is turned-on or the resel button is pressed, the control is pass to a
set of conlrol programs found in the ROM, a firmware store in computer chips, These
programs perform several tasks: (1) ta check if hardwares are functioning corréctly: (2) to
foad a set of control program from the disk to the memory; and (3) to pass control 16 a routine
which will accept the user input. At this point, the operating system is loaded and the user

can execute an application program such as MS-Windows, MS-Word, or Excel.-

An operating system by itself has two levels of functionality. The first level is seen by the
user running the applications and utitizing system coninands and utilities. Al this level, each
operaling system has its own set of command used to accomplish frequently performed tasks
such as copying files, cenaming files, and formatting disks.  Normally, frequently-used
functions are included in the operating system as system conunands.  The second is at the
progrimming fevel. All operating systems contain a set of pre-packaged routine which

performs the “primitive” functions necessary in almeost all applications. Such functions. like
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senditig a character to the sereen, reading and writing information from a disk fite, and
accepting input from the keyboard are common to nearly all programs.  This level of

functionality gives the programmer it sel of standardized routines to perform this fask.

Operating systems, such as DOS or UNIX contain many useful utilitics and provide a rich set
of Tunction, which simplify the progranmmer’s job writing application and controlling the

hardwares.

SOFTWARE

The operating system alone renders the computer neatly useless, unless the user is capable of
directly communicating to the hardware. In order to use the computer system, a software. is
needed. Various softwares are available for different purposes, such as MS-Werd for word

processing, Excel for spreadshiect and Foxpro for programming.

- MS-WINDOWS

MS-Windows is a popular software that duplicates the function performed by DOS at the
system fevel. Most of the commands are represented by descriptive figures called icons.

Navigating around the windows, is through a pointing device called mouse. To execute 4

. command, the user only need to bring the mouse pointer to the desired command described

by the icon and press the right button. - The execution stasts without typing any single

character in the keyboard, unliké the DOS convention that ﬁceds typing a serics of characters
comprising the filename. In windows, the computer screen is referred to as the deskrop.
When working; the application and documents must be in the windows. The windows on the
desktop must also be arranged. If an application is left for a while, the windows are shrunk to

an application icon, and still, the application keeps munning on the background. When an

application is shrunk, the windows place their application icon at the bottom edge of the

desklop until it is again restored to window size.

With windows, several powerlul applications can be mun simullancously.  For example,
switching from a word processing application to a spreadsheet, and then to database
application with a few simple moves while quitting one application and restarling another,

can easily be done.
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Two Kinds of Windows

Application windows contain running applications.  The name of the application; the
associated document, and the application’s menu bar appear at the top of the-application

window. Application windows can be positioned anywhere within the deskiop borders.

Document windows appear only with application that can open two or more documents at one
time inside the same workspace. For example, with Windows File Manager, onc can opea &
number of directories at the same time. Each directory appears in a separate document

window {called a directory window) in the File Manager workspace.

Parts of a Windows

Each application and some documents the user choose to work on, open as separate windows.

Every window has some common elements, however, not all windows use all the items.

The elements as ilustrated below are the tools for working with the window and the

application or docurnent within the window.

Mininvize bulton
Maximize button

Wipdow tille

insertion point
© ~ Control-meny BoX

Title bar

T2E ; = =
I file Edi Sezrch  Help ] —3 Menu bar ]
N Tl
‘ ‘ )
il
" T - Windaiw bordar
I .
F +— Vertical
i scroft bar
: o [+
X T N _ NI TR
Windew coraer \- Mouse pointer \ Horizontet scroff bar

‘The Control-menu box located in the upper-left comer of the window is the most useful
menu when the use of a keyboard is preferred.  The Control-menu comminds can resize,

ove. masimize, mminimize and close windows, and switch to Task List.
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The title bar shows the name of the application or documcnt. If more than one window is

apen, the title bar of the active window has a different color or intensity compared to the %
other title bars.

The window title, depending on the type of window it appears, can be the name of an

application and the name of the document, or a placeholder, In such case, “untitled”

narmally appears.

The menu bar lists the available menus. Most applications have a File menu, an Edit menu,

and a Help menu as well as other menus unique Lo the application.

“The Scroll bar can move the parts of the document into view when the entire document will
not fit in the window. With the bar, unscen portion of the lists and other information that is

too long te fit in the allotted space can also be viewed.

The Maximize and Minimize buttons enlarge the active application window to fill the entire
desktop or shrink the window to an icon. Document windows enlarge just to fill the
application workspace and not the entire desktop. After enlarging the window, the Maximize
button changes (o a Restore button. Restore bulton can be used to return the window to its
previous size. - ' | ' %
The Window border is the outside edge of a window. It can lengthen or shorten each side of

the border.
The Window corner can be used to shorten or lengthen two sides of a border at the same time.

The Workspace is where most of the work with an application are done. - For example, the
content of the documents appears in the workspace when starting a wordprocessor. Hence,

an_application can allow the opening of more than one document window within this

workspace.

The seleciion cursor shows where the user is in an individual document. It marks the place
in the text or graphics where (he user begins typing or drawing. The arrow-shape mouse
pointer appears if you have a mouse installed. It is used to indicate items the user wants to

select with mouse.
Starling Windows @‘

At the DOS prompt, type win and press ENTER.
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When starting windows, the Program Manager window is antomatically opened with the
Main Group window opening inside it and other window groups represented as group icons
located at the tower edge of the Program Manager window as show in the illusteation in

below.

Fila Masajt m Fonk Macepst C;ﬁ:ﬂ HP'SQ?::OS

Accessmes Gyt Sratlo 2pghostors

Quitling Windows

. Quit any application that are currently runbing.
. Click Program Manager's File menu Lo open it.
. Click Exit Windows. . .
The Exit Windows confizmation dialog box appears.
_Chick OK o exit windows.

Mouse

T D —

e

Keyboard 1. Quit any application that are cureently running.
Press ALT-F to open Program Manager's File Menu.
2. Press X (the underlined letter in Exit).
" Qr use arrow key to move the highlight to Exit Window
and the press ENTER:
3. The Exit Windows confirmation dinlog box appears.
4, Press ENTER to choose OK and exit windows.

Starting Window Application
To make starting application easy, Window offers three methods:
Choose i program item from a group window in Program Maaager.

Chooxse a program file from the appropriate directory window in File Manager,

Choose the Run cammund from the File meau in Program Manager of File Manager.
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Starting Applications from Program Manager

As long as an application belongs to @ group, the easiest way to start is to chaose from the
group window. If a document is included with the application, it will be loaded into the

application workspace.

Mouse 1. Open the Program Manager window, if not already open.
and open the group window that contain the application
you want to start.

2. Doubte-click the icon for the application.

Keyboard 1. Open the Program Manager window, if not already open,
and open the group window that contain the applicmion
you want to slart.

2. Use the arrow keys to move lhe highlight to the icon for
~ application.
3. Choose Open from the File menu and press ENTER.

Starting Applications from File Manager

You start an Jpphcauon from File ‘Manager by opemng the prograim file from a directory
window. You can execute an appllcmmn program file having .COM, .EXE, .PIF, or BAT
filename extensiot. If the application can run in a window eavironmient, the window will

appear in front of any File Manager windows that are open.

Mouse 1. Stant File Manager and open the dlrecmry wmdow
- that contain the progeam file.
2. Doubie-click the filename.

Keyhoard I. Stat Fite Manager and open the directory window
that contain the program file. _
2. Use the arrow keys to move the highlight to the icon for
“application.
3. Choose Open from the File menu and press ENTER.

Starting Applications with the Run Command

The Run command is a handy way to start applications that you want to run only occasionally
or have not yet added to @ group. You can open a document at the same time you slarl the
application.  Unless the program file is in your current path, you need to know the exact

directory location and name of the program file before you can start the application.

1. Choose Run from the File menu in Program Manager or File Manager.
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5.2.

The Run dialog box appears.

. Type the pathname and the exact ﬁlcnamg of the program file, including
the extension if there is one.

. If you want the application to shrink to an icon as soon as it starts, make
sure the Run Minimized check box contain an X.

4. Choose OK or press ENTER.

l'-.)

‘JJ

MS-EXCEL

xce! is a spreadsheet type of software package that operates under the MS-WINDOWS
operating system. The primary document in Excel is called a workbook. The woikbook is
similar to a ledger that stores information and each workboak is made up of sheets. The
sheet is virtually divided into colunm and row; the column run horizontally and denoted by an
alphabet staiting wilh A and the row run vertically and denoted by aumber starting from 1.
The intersection of column and row is called cell. The cell is the basic component of

worksheet that accept different data types. The most common data types are character,

number, date, logical value and formula.

Standard Toelbar
The standard toolbar that normally appears at the top of screen helps select opuom Such

options can opm workbook, priat and save worksheel and ask for help.  The follomn.v isa

list of the individual icons and their respective functions.

Excel’s Standard Toolbar

Bullon Nome " Funclion

D New Workbook “Creates a new workbook )
o

Lac. s Open Opens a document

Save Saves the active workbook
& '
=2 Print Prints the active workbook
[:6': Print Proview Shows the active documentin print proview
maode
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Excel’s Standard Toolbar

Naome Function

Speller Checks the spelling of the document

Cut Cuts the selection to the Clipboard

Copy Copies the selection to the Clipboard

Paste Piaces the Clipboard contents at the insertion

point

Format Painter Copies and pastes formats for cells and objects
Undo ~Undoes the last action or command

Repeat : Repeats the last action or command;

this is the same as the redo feature in Word 6

AwtoSum Inseris the SUM funciion and shows sum range
Funcion Wizard Starts the Funcdon Wizard
Sort Ascending Sorts selected rows in ascendihg order

Sort Descending So_rts: selected rows in descending order

ChartWizard -~ Acdvates the CharcWizard

Text Box ~Inseets extor text hox

Drawing “Turns the deawing toolbar on or off

53 o -
~—— b Zoom Contrel  Sets the view of the documient

“Tip Wizard Turns the TipWizard woolbar on or off
Help Displays Help
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Excel’s Formatting Toolbar

Bulton Name Funclion
. | 2 .
Arial . J ¥ Font Sets the font for the sclection
10 -_"l @' Font Size Sets the font size for the
e, selecion
=B"_._ i
i’ 2 " Bold Roldfaces the selection
7 |
“*‘i halic Talicizes the selection
o
i
?y-‘ Undecline Undeslines the selection
== Align Left Leftaligns the selection
. Center Centers the selection
- Align Right Righet-aligns the selecdon

" Center Across

Centers the selection across

a»
| d Columns columns
et L -
4 “Currency Changes the selecied cells 1o -
b Sple . defaulicurrency syle
e Percent Changes the seleceed cells 1o
. ‘E. ey .
; Sule default percent siyle
T X .
2 Comuna Changes the selected cells to
kK Siyle default comma style
‘?"—6— Increase Adds one decimal place <o
-00 Decimal the number format
— 3 N B i «
oo Decrease Removes one decimal place
+.0 Decimal - from the number formar
I,-, ] i Borders Enzbles you o selecta
— border for the selection - -
‘%’ f;! Color Sets the color [or the
HL-e=r o selection
I Font Color

&)

Sets the color for the selected
font -
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Basic Part of Excel Screen
Memny bcr

‘Figules \rmnmns _
L]

Workboolk ———

i | el e e P

-! =i ..{ TR

Ready 3.5 h | B
.

MS-Excel Basic Qperation Worksheet

Follm\;'ing the description of the basic operation, the mouse is used as a pointing device
instead of a keyboard. The word click means the user must press the left button of the
mduse; double click means two successive clicks; and enter means the user must press the -
Enter key in the keyboard. - Basic operation dealt 6:1Iy to the routine necessary to update the

PWA4SP data base,

Creating a New Weorksheet

When you enter Excel, it opens up to a new workbook, by default it contain 16 worksheets.
You can use any of the worksheets. Even if there is an open workbook, you can stili open
aflother by moving the mouse paimcr'in the New icon (upper left of the screen below the

menu Bur). Chick on it

Saving the Workbook

1. Move mouse pointer to File menu and chick on'it to bring the File menu option.
2. From the aption available. Select Save.
3. I the document your saving is new. The Save Ax diadog box appear. In the File Name
box type the name of the workbook.

Enter Datain a Cell
1. First select the celf by moving the mouse pointer and clicking the

right button. This routine place the insertion pointin the active cell,
which is highlighted on-screen with border avound i,
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2. You can start entering the data from your keyboard or nmeric keypad.
3. To confirm the input, you can press ENTER or move the mouse pointer
to the Formula bar and click the Check icon.

Editing Cell Contents

{. Double-click the cell containing the data you want to edit.
To edit in the formula bar, click in the formula bar. In case the formula
bar is not dispiayed, choose Formula Bar from the View menu located
at the top row of screen.

2., Fdit the cell contents,

3. To confinm the modification made in the cell, click the Check icon in the
formula bar or press ENTER. To cancel Ldm click the Xicon in the
formula bar or press ESC.

Clearing Cells

1. Select a cell or range of cells that you want te clear.

2. From the Edit menu, choose Clear, and from the option available,
you the choose All, Contents, Formats, or Notes.
Shortcul; Press DEL.

To clear cells by dragging

1. Select a celt or range of cells that you want to clear.

2 Move the mouse pointer in the fill handle (lower right corer),
drag the fill handle toward the area of cell or range, then the selected
area will become gray.

3. Release the mouse button.

Copyiug Cells

f. Select the cells containing the data you want to copy.
~ 2. From the Edit menu, choosc Copy.
3. Select the upper-left cell of the paste area.
Beware that any values or fornta in the paste area will be replaced

Undo Command

1. To undo your last command, click the Undo button,
From the Edit menu, cheose Undo.

Creating Border around Cell

1. Choose the Cell menu from Format menu.
2. Choose the side you want put the border, and then choose type of border.
3. Click OK button.

Deleting Rows and Columns

1. Select the row or column
To delete miore than ene row or column, extend the selection to include
all the rows or columns you want to delete.
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2. From the Hdit menu, choose delete {(Entire rows or column)
3. Ciick OK bution

Inserfing Rows and Columss

1. Select the row or column
To insert more than one row or column, extend the selection te inchude
the number of rows of columas you wanl {o insent.
2. From the Edit menu, choose lsert (Entire rows or column)
" 3. Click OK button.

Setecting a Sheet or Sheets
Ta select a single sheet, click the sheet tab.
To select two or more sheets
1. Click the sheet tab for the first sheet you want to select.
2. i the sheets you want to select are adjacent, hold down the SHIFT key
and click the tab for the last sheet, ,
If the sheets you want to select are non-adjacent, hold down the CTRL key

and click the other sheet tabs.,

Ungroup Sclected Sheets

1. Move the mouse pointer to the sheet tab. Click the left button of the mouse.

2. While the mouse pointer still on the sheet tab, click the right buiton and
choose the Ungroup Sheets. '

Inserting Workshect

1. Select a sheet or sheels in the workbook.
2. From the Insert menu, choose Worksheet.

The new shect or shects will be inserted to the left Qf the sheet tab you select.

Shortcut: SHIET+EL]
Deleling Worksheet

I. Select a sheet or sheets in the workbook. _
2. Move the imouse pointer to the sheet tab, and click the right button.
3. Choose Delete, and click the OK bution.

Moving Worksheet Within the Workbook

1. Select the sheet or sheets you want to move.

2. Drag the setected shecet tab along the row of tabs.
A black triangle indicates the place where the sheets will be inseried.
All selected sheets will be inserted.

3. Release the mouse button.
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Alternate Methed

i. Seleet the sheet or sheets you want to move.,

2. From the Edit menu, choose Move or Copy Sheet,

3. In the Before Sheet box, select where you want sheets to be inserted.
4., Click the OK button.

Moving Sheets to Other Workbook

1. Open the workbooks you want to move sheets fo and from.

2. Select the sheet or sheets you want to move.

3. From the Edit menu, choose Move or Copy Sheet. .

4. In the 'To Book box, select the destination workbook.

5. In the Before Sheet box, select where you want the sheet or sheets inserted.
6. Click OK button.

Alternative Method

1. Open the workbooks you want ta move sheets fo and from.
2, From Window menu, choose Arrange and choose horizontal.

In the desktop, twe workbooks will open in screen split the workarea horizontally.

ot

. Select the sheet or sheets you want to move.
4. Hold-down the CTRL key and the right button of the mouse.
A paper icon and black triangle indicate that you made the move routine 'lcme
5. Drag the mouse pointer to the other workbook and select where you want
the sheet or sheets inserted.
6. Retease the mouse button,

Copying sheets withia a workbook

I Select the sheet or sheets you want to copy
2. Hold down the CTRL key and mouse left button, and then dmg the selected
sheet tab along the row of tabs. A black triangle indicates the place where
" the copicd sheet will be inserted. :

3. Release the mouse button and then the key

Alternative Method

I. Select the shéet or sheets you want to copy.
2. From the edit menu, choose Maove or Copy Sheet.
3, In the Before Sheet box, select where you want the copied sheet inserted,
4. Select the Create’ A Copy check box.
5. Click the OK button,

Copying sheets to other workhook

1. Open the workbook you want (o copy 1o and Trom.

2. Select the sheet or sheets you want to copy.

3. From the Edit menu, choose Move Or Capy Sheel.

4, In the To Book hox, select the destination workbook.

5. In the Before Sheet box, select where you want the copicd sheet inserted.
6. Select the Create A Copy cheek box.

7. Choose the QK Button.
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Printing your Work

{.
2,

From File menu, choose Page Sctup to display the Page Setup dialog box.

On Page Setup dialog box, their are four option available

Page tab controls page oricatation, scaling, page size, print quality, and
starting page number for the selecied sheet.

Margin tah controls page margins and the header and footer margins, and
center the sheet on the page vertically, horizonlally or both.

" Header/I'ovter tab controls page the headers and footecs for the selected sheet.

headers and footers are descriptive text that print at the top and bottom of
every page in your sheet. You can add, delete, edit, format, and position
headers ond footers, and view them as they will print.

Sheet rab specifics which areas of the sheet you want to print, and controls
the print titles, page order, and draft quality. Also controls whether
gridlines, cell notes, and row aind column heading print. The Sheet tab is
displayed if the active sheet is a worksheet or macro sheel.

. On the Print What, their are three option available.

Selection option prints only the sclected cells in the selected sheets.
Nonadjacent selections are printed on scparate pages. Selecting this
overrides any print arcas you have defined for the selected sheets using
Print Area option on the Sheet tab of the Page Setup dialog box.
Selected Sheets option prints the area of each of the currently selected sheets,
wilh each print atea starting on a different page. If no print area is defined
on a separate sheet, the entire sheet is printed.
Entire Workbook option prints the entire print area of all sheets in the active
workbook. If a sheet does not have a print area, that entire sheet is printed. %

. On the Copies bex, specifies the number of copies to print.
. On the Page Range, their are two option available.

All option print all the pages in the selected sheets.

Page(s) eption print the range of pages specified in the From and To boxes.
Page numbers you selected in the From and To boxes affect which cells
will be printed, not the numbering of the pages upon which they are
printed. To change the numbering of printed pages, specify a number in
the First Page Number box of the Page tab in the Page Setup dialog box.

6. The user have option lo see the appearance of the print by clicking the

1.

Print Preview button.
Printer Setup option give the user an option to select among the available
printer drivers.

8. Click the OK button to proceed printing.

MS-\WORD

MS-Word is word processing lype of software. This is analogous of converting your

computer into typewriter machine. You have page in which you type characters, you have a

culer that show where you are as you type across the page. You have tabs stops and margin

setiings. The insertion point moving across the page even acts like the print head moving

across the page.
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MS-Word offer more advance features that you nced to create from simple to complex type
of document. When you start Word you will notice almost the identical appearance with that
of MS-Excel. Mos! of the command are represented in terms of icon, in the middle of the

workspace were you enter your text and other object included in your documents.”

Slartihg Word

From the MS-Window environment, you can double-click the MS-Word icon in the MS-
Office progrant group. In some case the MS-Office administrator is automaltically loaded at
start-up of Windows environment. The MS-Office administcator menu icons are located in

the upper right side of the screen. You can start MS-Word by clicking the icon,
Quiting Werd

1. Move inouse pointer to File menu and ctick. File sub-menu will appear.
2, From the File sub-menu, move mouse pointer to Exit option and click.
The MS-Word enviconment will normally terminate. In some cases, if some aclive
~documents has not yet been save. MS-Word give the user’s oplion to save the
documents,

Standard Toolbar

The standard ioolbar which normally shown at the top of screen helps you select the option,
from this loolbar The user's can open new documenl open existing document, print and save
documcn!, and ask help to facther undersland some function or procedure to accomplish

desired !ask_. Using the toolbar speed-up the desire task instead of using the menu (located at

-the top of the screen). The following shows the list of standard. toolbar icons and their

function.
Standard Toobar lcons
kon Nome Description
D New Creates a new file based on the Normal tefnplate )
s Open . - Dlsplays the Qpen dialog box so that you can select an

existing file to open

Save Saves the current document

@ Print Print the current document

Print Preview Acmams Word's print proview leatures

Spelling Initiates a spelling check
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Standard Toobar lcons

lcon Nome Description
‘x, Cut Cuts selected material to the Windows Clipboard
3 . . .
: Copy Copies selected maierial to the Clipboard
Paste Pastes material from the Clipboard into your docu-

ment

Format Painter

Copies the formazting of a selection to the textyou
specify

.’-n‘"'_‘: §1 Undo Undoes the commands you select from the fist
A0 - presented
3 11 Redo Redocs the cammands you select from the tist pre-
[ faid

= sented
N . .
- AutoFormat Formats your document autornatically

Insert AutoText  Inserts an AutoText entry

Inscrt Table

Inserts a table fnto your document

Insert Excel

Inserts an Excel worksheetinto

Inter¢ Chart

Worksheet your decument

Columns Formats your document using ¢olumns
by Drawing Opeans the drawing application and enables vou to
iz draw a picture in your document,
Nt

Inserws a chart into your document

bl

Zoofn Control

Scales your view of the document by the percentage
you select o :

S

' Help

Activates contextsensitive help

- MS-Word Bas_.ic Operation

Opcning and Existing Document

I. Click the Qpen Folder icon {normally second from the left) to bring up the open
dialog box.
2. In the Open Dialog box, select the file you to open from File Name combination

box.

3. Click the OK button.

Changing the Format of the Text

1. Click the arrow button to the right of the fourt box to bring the list of available font.
2. Scroll through the tist box by clicking on the scrolt bar, and setect i font by clicking

onit.

3. Begin typing. The text will appear in the font you just selected.
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Changing the Font Size

1. Click the arrow bulton to the right of the font size box to bring the list of available
size.

2. Scroll through the list box by clicking on the scroll bar, and select a size by clicking
onit.

3. Begin type. The text will appear in the font size you size selected.

Choose a Style

Perform any of the following procedures to change a font style:
¢ Click on the button labeled B to sel the bold feature on.
You also can press Ctrl+8B from the keyboard.
o Click on the button labeled 1 1o set the itafic feature on.
You also can press Cuil+1 from the keyboard.
o Click on the button labeled U to set the wnderfined feawure on.
You also can press Ctel+U from the keyboard.
¢ Click on the button labeled B and I to set both bold and itafic features
You also can press Ctrl+B followed by Ctel+{ from the keyboard.

Setting Special Effects

You can use a vagiety of sp'ecial text effects:
s Strikethrough

Superscript

Subscript

Hidden

Swiall caps

All caps

To set any of these features, use the foltowing procedure:

1. Open the Format meau and select the Font item,

2. If the Fonts tab is not on top, click on it.

3. Inthe Effect group box, select the check box th(u reprcscnt the special effect
you want to turn on. :

4. Click the OK button.

5. Begin typing. Your text appears with the special effect you selected.

Selting the Indentation

1. Open the Format menu and select the Paragraph item.

2. If the Indents and spacing lab is not on top. click on it.

1. In the indentation group box, vse the Left and Right spin boxes to set the indentation
from the left and right margins. Click on the arrow buttons until the measurenicnt is
correct, or select the text in the body by highlighting it with the mouse and thei type
exact measurement you want.

4. To set first line or hanging indentation, open the Special drop-down list box by

g clicking on its arrow, and select the appropriate item. Use the By spin box to set the
measureinient for the first line indentation or the hanging indentation.

5. Click the OK button. Your current paragraph takes on the indentation you just set.
Bach subsequent paragraph you create takes on this pattemn, unless you resct the

. indemtation using the dialog box.
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Sctling Line Spacing

1. Open the Format menu and select the Paragraph item.

2. 1f the Indents and Spacing tab is not on top, click on it.

3. In the Spacing group box, use the Before and After spin boxes to set the distance in
points from the previous paragraph and from the following paragraph. Click on the
arrow buttons unti! the measurentent is correct, or select the text in the box by
highlighting it with the mouse and then type the exact nmcasurcment you want.

4. To st line spacing within the paragraph, open the Line Spacing drop-down list box by
clicking on its arrow, and select the appropriate item. Then use the At spin box to set
the measurement Tor number of lines or distance between hines, whichever is active.

5. Click the OK button. Your curreid paragraph takes on the line spacing you just set.
Each subsequent paragraph you create takes on this pattér, unless you reset the line
spacing using the dialog box.

Copying and Inserting Text

1. Highlight the text by dragging (he mouse pointer over the fext to be selected.

2. Move pointer to Copy icon and click on it.

3. Move mousc pointer to the place were you would like the insertion take place.

4. Move mouse pointer to Paste icon and click on it. Alternatively, you can press the right
button of the mouse to bring the menu option., select the paste by click on it.

Undoing and Redoing

If you do make a mistiuke; you can undo it by selecting the Undo option from the Edit menu.
This procedure undoes the last change you made to the document. Word always will add the
name of the operation you are about to undo as the second word of the Undo menu item. If

you canrivt undo anything, this option change to Can’t Undo and is dimmed.
Overstriking Text

There are times, however, when you want to type over existing text. To switch to this ediling
mode, press the Insert key in the keyboard. When you type, the characters you type replace
any characters to the feft of the insertion point. To tur off the overstrike mode, press the

Insert key again.

" Deleting Text
“Use mouse pointer to highlight the desifc text and press the Del key from the keyboard.
Insert Fite
1. Move mouse pointer in the location were you would like the insertion take place.
2. From the Insevt menu, select Fite option.

3. From the File name combination bax. select the file you would like to insert.
Click the OK button.
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Creating the Header or Foeler

1. From the View menu, choose Header and Footer.
2. The Header and Footer toolbar appear, click the switch between Header
and Footer button. The header and footer arcas are enclosed by a nenprinting
dashed line.
3. Do one or more of the fallowing;
Text - You can type the text within the dashed line that surround the header
or footer arca.
Page Number - Click the icon.
Current Date - Click the tcon.
Curreint Time - Click the icon,
4. To return to the document, choose the Close button on the Header and Fooler
toolbar, oi double-click the main text area

Previewing the Document

1. From the File menu, choose Print Preview.
While in the print preview mode, you can perforn the following options.
a) You can print the document by click the Print button,
" b) You can switch the imagnifier on and off by clicking on the magnificr button.
¢) You can switch to a one page view by clicking the One Page bulton.
d) You can switch to view multiple pages by clicking on the Multiple
Pages Button and dragging across the grid that appears, releasing the
mouse buttan when you have the multiple-page view you want (o usc.
_;g-_. £} You can zoom in or out on your document by adjusting the zoom
’ percentage in the Zoom Control drop-down list box. ‘
f) You can switch the view of the ruler on and off by clicking on the
View Ruler button.
£) You can squeeze a small amount of text on the final page into the
the outer pages by clicking on the Shrink to Fit button.
“h) You can expand the preview screen to show only the page, the
~ toolbar, and the status bar clicking on the Full Screen button.
I} You can exit the preview mode by clicking ori the Close button. -

Printing your Dacument

1. From the File menu, choose Print option.

A Print dialog box appear.

2. In the Print What drop-down list box. This option enables you (o print the
document or several items ancillary 1o the document, such as Suminary Info,
Amnotation, Style, Autotext Entries, and Key Assignments. '

3. Use the Copies box to enter the number of copies to print.

4. Use the Puge Range option to determine how much of the document to print.
You can print All the document, the Current Page, or selected Pages.

5. Check the Collate Copies check box to finish the first set of copy before
printing the second copy.

6. When all it set correctly, close all the dialog boxes you have open,

g and click OK button, the printing process begin.
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PW4SP DATA FILES

Data files are collection of information revelant to the preparation of PW4SP. Data files are
{ogically group into three major areas of information. The first group of information are the
base data that are composed of information derived from survey, ocular inspection, and
existing information from the provincial and national agencies. Fhe second group of
information are the key parameter data that are composed of information derived from
- applicable policies, assumption, water test result, and current cost uf'commodity. The third
group of information are the presentation of data which derived from the previously
- mentioned groups of information’s, this data are processed and then logically arranged to
show provincial profile, existing facilities and service coverage, past financial performance,
future requirement of the relevant sector, cost estimates for futire sector development, and

financial arcangement.

Base Informalion

1. Socio-economic Data (socio.xls)

‘a}  Administrative Composition { (M) Administrative Compaosition)
" b) Past Population ( (M) Past Population Page | 10 2) : %
¢} Projected Population ( (M) Projected Poputation) : '
d) Househald ( (M} Household)
e} = Services ( (M} Services)
)  Occupation ( {M) Occupation) o _
~ 2) Family Income, Education and Litesacy ( (M) Family Income and Education)

2. Land Use Data (landuse.x]s)

a) Existing Land Use ((M) Existing Land Use)
by Future Land Use (M) Fature Land Use)

A, Health Data (health.xls)

.a) Morbidity, Moriality and Infant Mortality (M) Morbidity and Morlalilyj
b} Facility and Practitioner (M) FacilityPractitioner)

4, Water Resource Data (h2ores.xls)

a) General Information ( (M) General Information)
~ b) Water Source Information ( (M) Source Information}

5. Water Supply Systems Data {h2osupp.xls) %

a) Leve! IH Systems ((8) Level HI PI-2 .. P2-2)
b} Level H Systems ((S) Lovel HP1-4 . P4-4)
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6.2,

6.3.

6. Environmental Saiitetion Dafa (sanit.xls)

a) Houschold Toilets ({M) Houschold Totlets)

b) School and Public Toilets ( (M) Sch. and Pub. Teilets)
¢) Drainage Facility ( (M) Drainage Facility)

d) Solid Waste Collection and Disposal { (M) Solid Waste)

. 7. Iivestment Data {invest.xis)

a) Previous Annual Investiment ( (P) Fin. Past Ann. Invest.)
b) Planned Annual Investment { (P} Fin. Futare Ann. Invest.)

- Key Parameter

I. Key Parameters (keypar.xls)

a) Key Parameter (Key Parameter)

b) Level [ - Safe and Unsafe (Level T Safe and Unsafe)
¢) Well Source Composition (Well Source Composition)
d) Unit Cost {Unit Cost)

¢) Scoring Factor (Scoring Factor)

) Annual Investment (Aanual [nvestment)

Data Presentation

1. Provincial Profile (chap-3'.x'ls)

“a) Outline of Cily and Municipatities (MTable 3.1.1)
b) Current Land Use (MTable 3.2.1)
¢) Drainage Areas and Flow Rates of Major Rivérs (M1 "able 3.2. 2)
&) Distribution of Households by Income Class (thum 330
¢} Population Distribution by Qccupation (Figure 3.3.2)
£) Population Distribution by Highest Altainment of Education (MFi lgure 333
g) Provincial Qutline on Public Services (MTable 3.3.1) :
h) Public Facilities and Services by Municipality (MTable 3.3.2)
i) Previous Population Development of the Province {(MFigure 3.4.1)
j) Previous Population Development by Municipality (MTable 34.1)
k) Present Population Distribution (MFigure 3.4. 2)
1) Outline of Usban and Rural Areas in the Province (MTable 3 A2
m) Household Numbers and Household Sizes (MTable 3.4.3)
n) Number and Rates of Ten Leading Causes of Morbidity,
Motality and Infant Mortality (MTable 3.5.1}
o) Reported Cases and Deaths of Notifiable Water Related Dme%u; {MTable 3.5.2)
p) Municipal Sotid Waste Collection and Disposal, and '
- Service Coverage in 1994 (MTable 3.6.1)
q) Number and Ratio of Population to Health Facilities
andfor Medical Practitioners (STable 3.5.1)
r) Types of Drainage Facilities (STable 3.6.1)
s) DENR Water Quality Criteris/Water Usage and Classification
for Fresh Water (STable 3.6.2)

2. Existing Facilities and Service Coverage (chap-4.x1s)

a) Information on Existing Level 11 Systems (MTable 4.1.2)
b) Information on Water District {(MTabte 4.1.3)
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¢} Information on Existing Level 1 Systems (MTable 4.1.4)
dy Information on Existing Level 1 Facilitics {MTable 4.1.5)
e} Water Supply Service Coverage by Municipality in 1994 (MTable 4.1.7)
) Water Supply Scrvice Coverage by Municipality (MFigure 4.1.1)
£) Sanitation Facilities and Service of Houschold Toilets, Urban and
Rural, 1994 (MTable 4.2.1)
h) Provincial Service Coverage of Household Toilet Facilities, 1994 (MFigure 4.2.1)
i} School Toilet Facilities and Service Coverage in 1994 (MTable 4.2.2)
j) Public Tailet Facilitics and Service Coverage in 1994 (MTable 4.2.3)
k) Details on Existing Level L Systems (STable 4.1.1 Sheet 1'to 4)
1) Details on Existing Level IT System (STable 4.1.2 Sheet | to 6)
m) Number of Level 1 Facilities by Safe and Unsafe Classification (STable 4.1.4)
n) Estination of Unsecved Population by Municipality (STable 4.1.5)
o) Estimation of Population Covered by Safe and Unsafe Source
by Municipality {STable 4.1.6 Sheet to 2)
p} Sanitatton Facilities and Service Coverage of Houschold Totlets
by Type, by Municipality, Uiban and Rural, 1994 (STable 4.2.1)

3) Past Financial Performance in Water Supply and Sanitetion (chap-6.x1s)

a) Previous Sector Investment to the Province by Concerned Agency (MTable 6.2.1)
b) Past Internal Allotmeat to the Province from Central Government (MTable 6.2.2)
¢) Affordabitity in Water and Sanitation Services (MTable 6.4.1)
d) Financial Indicators of Water Districts {MTable 6.5.1)
"¢} Loan Status of Water Districis (MTable 6.5.2)
f) Past Internal Revenue Allotment to Municipalities from
Centeal Government(STable 6.2.1) \@

4} Water Source Development (ch}\p T.xls)

a) Existing Groundwater Sources in the Province {MTab!e 711y
b) Work ¥Flow of Groundwater Availability Map (SFigure 7.3.1)
¢) Existing Spring Sources by Municipality (STable 7.4.1)

&) River Information and Related Data (STable 7.5.1}

) Water Quahty Analysis Results (STable 7.5.2)

f} Existing Well Sources (STable 7.6.1)

g) Standard ‘Spcmﬁuauon of Wells by Municipality (ST"&ble 1.6.2)

5) Fusure Requirement in Water Supply aid Sanitation Environment {chap-8.x1s)

1) Provincial Scctor Targets (MTable 8.2.1)
© 2) Base Year Service Coverage of Water Supply (MTable 8.2.2)
-3) Base Year Service Coverage of Household Toilets (MTable 8.2.3)
4) Base Year Service Coverage of Public School Toilets and
Public ‘Foilets (MTable 8.2.4)
5) Base Year Seivice Coverage of Municipal Solid Waste System in 1994 (MTable 8.2.5)
- 6) Futere Population by Urban and Rural Area by Municipality (MTable 8.3.1)
7} Projected Public School Enrollment and Number of Public Utility
by Municipality (MTable 8.3.2)
8) Population to be Served by Target Year (Water Supply) (MTable 3.5.1) @
9) Additional Number of Houscholds to be Served by Target Year
{Housechold Toilets) {(MTable 8§.5.2)
10) Additional Number of Public School Student to be Served by
Target Year (School Toilets) (MTable 8.5.3)
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11} Additional Number of Public Utilities with Sanitary Toilets
by Target Year (MTable 8.5.4)
12) Population to be Served by Urban Sewerage in Phase 1l (MTable 8.5.5)
13) Additionat Number of Urban Houscholds to be Served by
Municipal Sotid Waste System in Phase 1 (MTable 8.5.6)
14) Water Supply Facilities Required by Target Year (MTable 8.6.1)
15) Sanitation Facilities Required by Target Year (MTabte 8.6.2)
16) Number of Garbage Collection Trucks Required in Phase I (MTable 8.6.3)
17) Estimation of Base Year Service Coverage of Water Supply {STablc 8.2.1)
18) Population Coverage in Phase I Provided by Served Population
in the Base Year (STable 8.2.2)
19) Number of Households Served by Sanitary Toilets in the
Base Year {(1994)(STable 8.2.3)
20) Number of Public School Student Scrved by School Toilets in the
Base Year (STable 8.2.4)
21} Number of Public Utilities with Sanitary Toilets in the
Base Year (1994) (STable 8.2.5)
22) Households Coverage in Phase I Provided by Existing Facilities in the
Base Year (Household Toilets) (STable 8.2.6)
23) Public School and Public Coverage in Phase | Provided by
. Bxisting Facilities in the Base Year (STable 8.2.7)
24) Projected Number of Househotds by Urban and Rural Areas by
Municipality by Target Year (STable 8.3.5)
25) Projected School Enrollment by Municipality by Target Year (STable 8. 3 0)

© 26) Projected Number of Public Utilities by Municipality by Target Year (STable 8.3.7)

27) Population to be Scrved by Level Il System in Phase [ (STable 8. 5.1)
28) Population to be Served in Phase I{Water Supply) (STable 8.5.2)
29) Population to be Served in Phase 1 (Water Supply) {STable 8.5.3)
30) Additional Number of Households to be Served in

- Phase [ (Household Toilets) {STable 8.5.4)

" 31) Additional Number of Houscholds to be Served in

Phase 11 {Household Toilets) (STable 8.5.5)
32) Additional Number of Public School Students to be Serwd in
Phase I and 11 (School Toitets) (STable 8.5.6)

' 33) Additional Number of Public Utilities with Sanitary Toilets in

-Phase 1 and 11 (STable 8.5.7}
34} Urban Water Supply Facilities Requited by Target Year (STable 8.6.1)
35) Plan for Expansion of Existing Level 1l Systein (STable 8.6.2)
36) Rural Water Supply Facilities Required by Target Year (STable 8.6.3)
37) Urban Houschold Toilets Reqmred by Target Year (STable 8.6.4)
38) Rural Househo!d Teilet Required by Target Year (STable 8.6.5)
39) Public School Toilets Required by Target Year (STable 8.6.6)
40) Public Toilets Required by Target Year (STable 8.6.7)

0) Cost Estimates for. Future Sector Development (chap-10.x1s)

a) Unit Cosl of Facilities by Type and Servicé Level (MTable 106.2.1)

b) Construction Cost of Required Facilities by Municipality {(MTable 10. il
¢) Recurrent Cost (MTable 10.4.1)

d) Unit Cost of Level I (Deep Well - 40 mieter Depth) (STable 10.2.1)

¢) Unit Cost of Level T (Deep Well - 80 meter Depth (STable 10.2.2)

f) Unit Cost of Level I (Deep Well - 120 meter Depth) (STable 10.2.3)

g) Unit Cost of Level 1 (Deep Well Rehabilitation) (S Table 10.2.4)

b) Unit Cost of Level [ (Shatlow WeH - 18 meter Depth) (STable 10.2.5)
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i) Unit Cost of Level JE (600 Service Population) (STable 10.2.6)
1) Unit Cost of Level 1L (5,000 Service Population} (STable 10.2.7)
k) Unit Cost of Level I (10,000 Service Population) {(STable 10.2.8)
1) Unit Cost of Level 11 {15,000 Service Population) (STable 10.2.9)
m) Unit Cost of Flush Water Sealed with Septic Tank Toilet (STable {0.2.10)
n) Unitl Cost of Pour Flush with Double Pit Latrine {(STable 10.2.11)
0) Unil Cost of Veatilated Improved Pit Latrine (STable 10..2.12)
p} Unit Cost of School Toilet (STable 10.2.13)
q) Unil Cost of Public Toeilet (STable 10.2.14)
r} Construction Cost of Water Supply Facililies Required for
Phase I (2000) {(STable 10.3.1)
s} Construction Cost of Water Supply Facilitics Required for
Phase 11 (2010) (STable 10.3.2)
t) Cost of Sanitation Facilities Required for Phase 1 (2000) (STable 10.3.3)
u} Cost of Sanitation Facilities Required for Phase H (2010) (STable 10.3.4)

1) Financial Arrangements {chap-11.x1s)

a) Projected Internal Revenue Allotment for Medium-Term
Sector Development (MTable 11.2.1) .
b) Peojected Allotment of IRA (o the Relevant Sector by
- Component, 1996-2000 (MTable 11.2.2)
c) Financing chmruncnts by Scctor Component for the Provmcc (MT’lbIe 113, l)
d) Additional Fund Requirement for Medium-Term Plan (MTable 11.3.2)
) Internat Revenue Allotment for Water Supply and Sanitation Sector -
by Municipality (Medium-Ternt Development 1996-2000) (MTable | 1.3.3)
f) Relationship between Fonding Levels and Percent of Covemge
for Water Supply Sector (MFPigure 11.4.1) : .
g) Relationship between Funding Levels and Percent of Cmerage
for Sanitation Sector (MFigure 11.4.2) :
h) Municipal Investiment Need Ranking for Urban Water Supply (MTable 11.4. l)
" i) Distribution of Provincial IRA to Municipality for
Urban W'itcr_Supply (MTable 11.4.2)
j} Muaicipal Investment Need Ranking (MTable 11.4.3)
k) Percentages for Annual Investment (STable 11.3.1)
I} Comprehensive Investment Need Ranking of the Muhicipalitics (STable 11.4.1)

DATA FILES LINKAGES

Linkages arc logical connection between tecords in the data files. Through linkages, once the
user’s updatés the source data, all data in the streams of linkages are dynamically dpdaled.
Linkages are the convenient toals of updating refated data, these also shietd the wser’s from
the complexity of formula manipulation. With the aid of the data linkages the user’s can

" concentrate more in validating the source data.

The following table lists the logical connections for each worksheel.
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UPDATING PWA4SP DATA BASE

The folowing procedures are guide in updating the base data of the PW4SP din
management system, The word coltunn and row in this procedure mean the internal column

and row notation in the worksheet environinent.

Updating Sacio-economic Data Base

1. Click the File menu, select Open.
Short-cut: Click the Open button.
2. From the Open Dialog Box. Select the socio.xls filename.
3.1 To update the Administrative Composition Data,
click the tab of (M) Area and Population sheei.

¢ NEDA geopgraphic code: move mouse pointer 1o column A. Starting at the row
below the column description, select the data you would like to update and type the
new value. .

»  Municipal Name: move mouse pointer to column B. Starting at the row below the
column description, in reference o column A (NEDA geographic code) select the
* data you would like to update and type the new value.

& Cily: move mouse pointer to column C. Starting at the row below: the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.

o - Municipal: move mouse pointer to column 1. Starting at the row below the column
description, in reference to column B (name of municipality) %e!ecl the data you
would like to update and type the new value.

e Class: move mouse pointer to column E. Starting at the row: below the column
description, in reference to column B {(name of municipality) select the data yon
~would like to update and type the new value.

¢ Urban Barangay: move mouse pointer to column J. Starting at the row below the
column descriplion, in reference to column B {name of municipality) select the data
you would like to update and type the new value,

¢ Rural Barangay: nioye mouse pointer to colwmn K. Starting at the row below the
cotumn description, in reference to column B (name of municipality) sclect the data
you would tike to update and type the new value. :

3.2 To update the l’asl Populahon Data,
- click the tab of (M) Past Popufation Page I sheet.

e 1963: move mouse pointer to colwmn D. Starting at the row below the column
description, in reference to colump B (name of municipality} select the data you
would like to update and type the new value.

e 1918 move mouse pointer to column E. Starting at the row below the column
desceiption, in reference to column B (rame of municipality) select the data you
would like to update and type the new value,
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o 939 move mousc pointer to column K. Starting at the row below the columin
description, in reference to column B (name of municipality) sefect the data you
would like to update and type the new value.

v 1948: move mousc pointer {o column G. Starting at the row below the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value. '

e 1960: move mouse pointer to column H. Starting al the row below the column
description, in reference to colunm B (name of mmunicipality) select the data you
would like to update and type the new value.

e [970: move mouse pointer ta column I Starting at the row below the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.

" 1975: move mouse pointer to column . Starting ai lhe row below the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.

click the tab of (M) Past Papulation Page 2 sheet.

s Urban Population (1980): move mouse pointer o column D. Starting ai the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

. " Rural Population {1980). move mouse pointer to column E. Statting at the fow
" below the column description, in reference to column B {name of municipality) select
the data you would like to update and type the new value. '

o Urban Population (1990): move mouse pointer to column G. Starting at the row
below the column description, in reference to columa B (name of municipality) select
the data you would like to update and type the new value. :

o Rural Population (1920): move mouse pointer Lo column H. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value. :

o Urban Population (1994): move mouse pointer to column 1. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like lo update and type the new value.

"« Rural Popnlation (1994): move mouse pointer to column 1. Starting at the row below
the column descri'ption. in refetence to column B (name of municipality) select the
data you would like to update and type the new value.

3.3 To update the Popuiaﬁon Projection Data,
click the tab of (M) Project Population sheet.

»  Urban Population {2000): move mouse pointer to column 1. Staiting at the row
below the column description, in reference ta column B (name of municipality) select
the data you would like to update and type the new value.

e Rural Population (2000): move wouse pointer to column K. Starting at the row
below the column description, in reference to colunm B (nane of municipality) sclect
the data you would like to update and type the new value.

2- 141



o Urban Population (2010): move mouse pointer to column S. Starting at the row
below the cobmnn description, in refecence to column B {name of municipality) select
the data you would like to update and type the new value.

& Rural Population (2010). move mouse pointer to column U, Starting at the row
betow the column description, in refetence to column B (name of municipality) select
the data you would like to update and type the new value.

3.4 To update the Household Data,
chick the tab of (M) Household sheet.

Urban Household (1980). move mouse pointer to column D. Starting at the row
below the columa description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

Rural Household (1980). move mouse pointer to column E. Stating at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

Urban Household {1990): move mouse pointer to colomn G. Starting at the row
below the column description, in reference to column B (name of municipality) sclect
the data you would like to update and type the new value.

'

Rural Hotiselrold {1920). move mouse poi_n{er to column H. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value,

*

Urban Household (1994): moeve mouse pointer to column J. Starting at the row
below the column description, in reference lo column B {(name of municipality) select
the data you would like to update and type the new value.

Rural Houschold {(1994). move mouse pointer to column K. Smning' at the row
below the column description, in reference (o column B (name of municipality) select
1he data you would like to update and type the new value,

»

3.5 To update the Services Data,
elick the tab of (M) Services sheet.

Namber af Public Elementary School: move mouse pointer to column F. Starting at
the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

Number of Private Elententary School: move mouse pointer to column G. Statting -
at the row below the column description, in reference to column B (name of
municipality) select the data you would like to wpdate and type the new value.

Number of Pullic High Scitool: move mouse pointer to column [. Starting at the oW
below the column description, in reference to column B (name of municipality) select
(he data you wonld like to update and type the new value.

Nrumber of Private Ht’gia Selrool: move mouse pointer to column J. Starting at the
row below the column description, in reference to column B (name of municipatity)
select the data you would like to update and type the new value.

-

Number of Colleges: move mouse pointer to column L. Stasting at the row below the
column description, in reference to column B {name of municipality) select the data
you would like to update and type the new value.
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o Number of Hospitals: move mouse pointer to columin M. Starting at the row below
the column description, in reference o column B (name of municipality) sclect the
data you would like to update and type the new value.

o Number of Markets: move mouse pointer to column N, Starting at the row below
the columa description, in reference to column B (name of municipality) select the
data you would like to update and type the new value.

o Number of Banks: move mouse pointer to column O. Starting at the row below the
column description, in refercnce to column B (name of municipality) select the data -
you would like to update and type the new value.

3.6 To update the Occupation Data,
click the tab of (M} Qccupation sheet.

o Number of Professional, Technical and Related Workers: move mouse pointer to
column D. Starting at the row below the column description, in reference to column -
B (name of municipality) setect the data you would like to update and type the new
value.

o Number of Administrative, Executive and Managerial: move mouse pointer to
column E. Starting at the row below the column description, in reference to column B
(nane of municipatity) select the data you would like to update and type the new
value.

o Number of Sales Workers: move mouse pointer to column F. Starting at the row
below the coluinn description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

o Number of Service Workers: move mouse pointer to columna G. Starting at the row
below the coburin descriplion, in reference to columa B (rame of municipality) select
the data you would like to update and type the new value.

o Number of Agricultural, Animal Husbandry & Forestry Workers, Fisherman and
Tlunetrs, move mouse pointer to column H. Starting at the row below the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.

s Nwmber of Production & Related Workers, Transportation Equipment Operators
and Laborers: move mouse pointer to column L. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

o Number of Occupation Not Adequately Defined or Reporred move mouse pointer
ta column J. Starting at the row below the column description, in reference to cotumn
B (name of municipality) select the data you would like to update and type the new

- value.

3.7 To update the Family Income, Education and Literacy Data,
click the tab of (M) Family Income and Education shect.

e Number of Family Receiving Under P 13,999: move mouse pointer to colunm D.
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

e Number of Family Receiving Between P 15,000 to P 29,999: move mouse poinier
to column E. Starting at the row below the column desceiption, in reference to
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3.2.

column B {(name of muaicipality) select the data you would like to update and type
the new value,

Number of Family Receiving Between P 30,000 to P 39,999 move mouse pointer

to column F. Starting at the row below the column description, in reference to
column B (name of municipality) select the data you would like to update and type

the new value.

Number of Family Receiving Befween P 40,000 to P 59,999: move mouse peinter
to colemn G. Siarting at the row below the columi description, in reference 1o
column B (nane of muaicipality} select the data you would iike to update and type

the new value,

Number of Family Receiving over P 60,000. move mouse pointer to column H,
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

Nwmber of Population that Finish Pre-School: move mouse pointer to column 1.
Starting at the row below the column descriplion, in reference to colwmn B (name of
municipality) select the data you would like to update and type the new value.

Number of Population that Finislht Elementary Schoel: move mouse pointer (o

~column J. Starting at the row below the column description, in reference to column B

{nrame of muanicipality} select the data you would like to update and iype the new
value. :

Number of Population that Finish High Sehool: move niouse peinter to column K.

- Starting at the row below the column description, in reference to column B (iame of

municipality) select the data you would like to update and type the new value.

Number of Population that Finish College and Post Graduate, move mouse pointer
‘to column L. Starting at the row below the column description, in reference to

colvmn B {pame of mumcipahty) selec! the data you would like to updite and type
the new value.

Number af Literate Population: move mouse pumter to column M. Statting at the

‘row below the'column description, in reference to column B (name of nmnicipality)

select the da._n you would like to update and type the new value.

Number of Hliterate Population: move mouse pointer to column N. Starting at the
row below the column description, in reference to column B (name of municipality)

© " select the data you would like to update and type the new value.

Updating Land Use Data Base

I. Click the File menu, select Qpen,
Short-cut: Click the Open button.
2. From (he Open Dialog Box. Select the lesduse.xis ﬁlcname.

" 3.1 To update the Existing Land Use Data,

click the tab of (M) Existing Land Use sheet.

Forest Land Area: move mouse pointer to column C. Starting at the row below the
column description, in reference to columin B (name of municipality) setect the data
yout would like to update and type the new value.
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Grass Land Area: wove mouse pointer to column D. Starting at the row below the
column deseription, in reference to cofumn B (name of municipality) select the data
you would like to update and type the new value.

Built-up Land Area: move mouse pointer to column E. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value,

Agricultural Land Area: move mousc pointer to colunma F. Statting at the row below
the column description, in reference to column B (name of municipality) select the
daa you would like to update and type the new value.

Mangrove, Fishponds, In-land Area: move niouse pointer to column G. Staiting at
the row below the column descriplion, in rteference to column B (name of
municipality) select the data you would fike to update and type the new value.

Open Land Area. move mouse pointer to column H. Starting at the row below the
column description, in reference (o column B (name of municipality) select the data
you would like to update and type the new value.

3.2 Te update the Future Land Use Data,
click the tab of (M) Future Land Use sheet.

Forest Land Area: move mouse poinier to column €. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you wonld like to update and type the new value.

Grass Land Area: move mouse pointer to column D. Starting at the row below the
column descriplion, in reference to column B (name of municipality) scleet the data
you would tike to update and type the new value.

Built-up Land Area: move mouse pointer to column E. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and {ype the new value. '

Agricultural Land Area: move mouise pointer to cofumn E. Starting at the row below .
the column description, in reference to column B (name of municipality) select the
data you would like to update and Lype the ncw value. '

Mangrove, Fishponds, In-land Area: move mouse pointer (0 column G. Stasting at
the row below the column description, in reference to columh B (name of
municipality) select the data you would like to update and type the new valve.

Open Land Area: move mouse pointer to column H. Starting at the row below the
column description, in reference to column B (name of municipality) select the data

* you would like to update and type the new value.
Updating Health Data Base

I. Click the File menu, select Open.
Short-cul: Click the Ogpen button.
2. From the Open Dialog Box. Select the ficalih.ads filename.
3.1 To update the Morbidity, Mortality aud Infant Mortality Data,
click the tab of (M) Morbidity and Mortality sheet.
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o Number of Morbidity Case: move mouse pointer to column E. Starting at the row
below the column description, in reference to column C (nanmie of discases) select the
data you would like to update and type the new value.

o Number of Mortality Case: move mouse pointer to column F. Starting at the row
below the column description, in reference to column C (name of discases) select the
data you would like to update and type the new value.

o Namber of Infant Mortality Case: mave mousc pointer to colunin G. Starling at the
row below the column description, in reference to column C (name of diseases)
select the data you would ke to update and type the new value.

3.2 To update the Facitity and Practitioner Data
click the tab of (M) Facility and Practifioner sheet.

e Number of Hospital Facility. move mouse pointer to column D. Starting at the row
below the column description, in reference to columi B (name of municipalily) select
the data you would like to update and type the new value.

e Number of Rural Health Unit (RHU): move mouse pointer to column E. Starting at
the row below the column descriplion, in reference to column B (name of
mumupmt},) select the data you would like to update and type the new value.

* Number of Barangay llealth Station (BHS): move mouse pointer Lo column K
Starting at the row below the column description, in reference to column B {(name of
municipality) sclect the data you would like {o update and type the new value.

¢ Number of Practicing Doctors: move mouse pointer to column H. Stasting at the %
tow below the column description, in reference to column B (name of municipality) '
select the data you would like to update and type the new value.

o Number of Practicing Nurses: move mouse pointer (o column L. Starting at the row
below the column description, in reference to column B {(name of municipality) select
the data you would like to update and type the new value.

e Number of Praclrcmg Midwives: move mouse pointer to colomn ). Starting at the
row below the column description, in reference to column B {name of mumcupll ty)
select the data you would like 1o update and type the new value.

o Number of Practicing Dentists: move mouse pointer to column K. Starting at the
row below the column description, in reference to celumn B {name of municipality)
select the data you would like to update and type the new value.

Updating Water Resources Data Base

I. Click the File menu, select Qpen.
" Shoit-cut: Click the Open button.
2. From the Open Dialog Box. Select the /i20-res.xls fitenwme,
‘3. To update the General Information Data,
* click the tab of (M) General Information sheet.

s Number of Shallow (General Information). wmove mouse pointer to column EfH.
Starting at the row below the column description, in reference to column C %%
{description of information) select the data you would like to update and type the
new value.
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o  Number of Deep Well (General linformation): move mousc peinter to column I/
Starting at the row below the column description, in reference to column C
(desceiption of information) select the data you would like to update and type the
new value.

s Number of spring (General Information): move mouse pointer to column G/,
Starting at the row below the column description, in reference to column €
(description of information) select the data you would like to update and lype the
new value.

Nete: To add succeeding municipality. Copy (M) General Inforniation sheet and
erase the default data and type the new data following the aforementioned
procedures.

8.5.  Updating Water Supply Data Base

1. Click the File menu, select Open.
Short-cut: Click the Open bulton.
2. From the Open Dialog Box. Select the i12osupp.xis filename.
3.1 To update the Level I System Data,
click the tab of (S) Level I P1-4 sheet.

s Data: move mousc pointer to column G.Starting at the row below the column
description, in reference to column B (Info Description) select the data you would
g like to update and type the new data. '

click the tab of (S) Level HI P'2-4 sheet,.
¢ Data: move mouse pointer to column G.Starting at the row below the colunm

“description, in reference to column B (Info Description) ‘select the data you would
like to update and type the new data. ~

click the tab of (5) Level I P34 sheet.

¢ Data: wove mouse pointer to colamn G.Stating at the row below the column
description, in reference to column B (Info Description) select the data you would
tike to update and type the new daia.

* click the tab of (S) Level HI P4-d sheet.
¢ Data: move mouse pointer to column G.Starting at the row below the column
description, in reference to column B {Info Description) select the data you would

like to update and type the new data,

3.2 To update the Level 11 System Data,
click the tab of (S) Level 1T Pi-2 sheel.

g ¢ Data; move mouse pointes to column G.Stasting at the row below the celumn
description, in reference to column B (Info Description} select the data you would
like to update and type the new data.
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click the tab of (§) Level IF P2-2 sheel.

L

‘Data: move mouse pointer to column G.Starting at the row below the column

description, in reference to column B (info Description) select the data you would
liké to update and type the new data.

3.3 To update the Level I Facility Data,
click the tab of (F) Level I sheet.

Public Facility:

Deep Well: move mouse pointer to column E. Starting at the row below the coluwin
description, in reference to colunm B (name of municipality) select the data you
would like to update and type the new value.

Shaliow Well: move mouse pointer to column F. Starting at the row below the
column description, in reference to column B (name of mumc;pal:ty) sclect the data
you would like to update and type the new value.

Coveredflmproved Dug Well: move mouse pointer to column G. Starting at the row

below the column description, in reference to column B (name of mumc;pﬂny) select
the data you would like to update and type the new value,

Open Dug Well: move mouse pointer ta column H. Starting at the row below the

columin deseription, in reference to column B (name of municipality) select the data
you would like te update and type the new value.

Developed Spring: move mouse poimer to.column I. Smr(ing at the row below the

- column description, in reference to column B (name of munlc:pallty) select the data

you would like o upd'\te and type the new value.

Undeveloped Spring: move mouse pointer to column J. Starting at the row below the
column description, in reference to column B {name of municipality) sclect the data
you would like to update and type the new value.

Private Facility:

Deep Well: move mouse pointer to column L. Starting at the row below the column

*description, in reference to colwmn B (name of municipality) select the data you
- would like to update and type the new value.

- Shaflow Well: move mouse pointer to column M. Starting at the tow below the

column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

Coveredfimproved Dug Well: move mouse pointer to column N. Starking a1 the row
below the colunin description, in reference to column B (name of municipality) select
the data you would fike to update and lype the new value.

Open Dug Well: move mouse pointer to column O. Starting at the row below the
column descriptien, in reference to column B (name of municipatity) select the data
you would like to update and type the new value.
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¢ Rain Collector: move mouse pointer to column P. Staiting at the row below the
colamn description, in reference to column B (name of municipality) select the data
you would like to update and type the new value,

Updating Environmental Sanitation Data base

{. Click the File meau, select Qpen.
Short-cut: Click the Open button.
2. From the Open Dialog Box. Sclect the sanit.xls filename.
- 3.1 To vpdate the HTouscheld Toilet Data,
click the tab of (M) Household Toifets sheet.

o Number of Urban Households Using Water Sealed Flush Toilet: move mouse
pointer to column C. Starting at the row below the colunin description, in teference
to column B (name of municipality) select the data you would like to update and type
the new value.

e  Number of Rural Households Using Water Sealed Fiush Toilet: move mouse
pointer to column D. Starting at the row below the colunin description, in reference
to column B (naine of municipality) select the data you would like to update and type
the new value.

s Number of Urban Houscholds Using Water Sealed Pour Flush Toilet: move mouse
pointer to colwmn E. Starling at the row below the column description, in reference to
cotumn B (name of muniupahty) sefect the data you would like to-update and type
the new value.

o Number of Rural Households Using Waler Sealed Pour Flush Toilel: move monse
pointer to column F. Starting at the row below the columm description, in reference to
column B (name of mumcnpdhly) sefect the data you would like to update and type
the new value.

o  Number of Urban Households Using VIP Latrine Toilet: move mouse pointer to

" column G. Starting at the row below the column description, in reference to column

B (name of municipality) select the data you would like to update and type the new
value.

o Number of Rural Households Using VIP Latrine Toilel: move mouse pointer to

column H. Statting at the row below the column descriplion, in reference to colunmin

B (nrame of municipality) select the data )ou would like to update and type the new
vatue.

o Number of Urban Households Using Unsanitary Toilet: move mouse pointer (o
column K. Starting at the row below the column description, in reference to columa
B (name of municipality) select the data you would like to update and type the new
value.

v Number of Rural Households Using Unsanitary Toilet. move mouse pointer to
column L. Starting at the row below the column description, in reference to colunin B
(name of municipality) select the data you would like to update and type the new
value.

o Nuntber of Urban Households Without Toilet: imove mouse pointer to column N.
Statting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.
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o Number of Rural Households Withont Toilet: move mouse pointer to column O.
Starting at the row below the columin description, in reference to cotumn B (name of
municipality) sclect the data you would like to update and type the new value,

click the tab of {M} School Toilets sheet.

o Number of Public School: move mouse pointer to colwimn C. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

o Number of Private School. move mouse pointer to column 1J. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

o Number of Student in Public School: move mouse pointer to column F. Starting at
the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new valuc.

¢ Number of Student in Privafe School: move mousc pointer to column G. Starfing al
the row below the column description, in refefence to column B (name of
municipality) sclect the data you would like to update and type the new value, -

s Number of Sanitary Toilets in Public School: move mouse pointer to column 1.
Starting at the row below the column description, in reference to column B (pame of
municipality) selcet the data you would like to wpdate and type the new value.

»  Number of Sanitary Toilets in Private School: move mousc pointer (o column J.
Starting at the row below the columin description, in reference to column B (name of
municipality) select the data you would like to update and type the new value,

»  Number of Unsanitary Toilets in Pablic School: move mouse pointer to column L.
Stasting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

s - Number of Unsanitary Toilels in Private School: move mouse pointer (o column M.
Starting at the row below the columa description, in reference to column B (name of
“municipality) select the data you would like to update and type the new value.

click the iab of (M} Public Toilels sheet.

¢ Number of Public Markels: wove mouse pointer to column C. Starting at the row
. below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

o Number of Sanitary Toilets in Public Markets: move mouse pointer to column D.
© Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would tike to update and type the new value.

o Number of Unsanitary Toilets in Public Markets: mové mouse pointer to column E.
 Starting at the row below the column description, in reference to colunmn B (name of
municipality) select the data you would like to update and type the new value.

o Number of Jeepney/Bus Terminals: move mouse pointer to column G. Starting at
the row below the column description, in reference lo column B (name of
municipality) select the data you would like (o update and type the new value.
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Number of Sanitary Toilets in Jeepney/Bus Terminal: move mouse peinter to
column H. Starting at the row below the columin description, in reference to column

"B (name of municipality) select the data you would like to update and type the now

value,

Number of Unsanitary Toilets in Jeepney/Bus Terminal: move mouse pointer to
column L. Starting at the row below the column description, in reference to colupin B
(hame of municipality) select the data you would like to update and type the new
value.

Number of Parks/Playground: move mouse pointer to column K. Starting at the row
below the column description, in re_fcrence to column B {(name of municipality) select
the data you would like to update and type the new value. :

Number of Sanitary Toilets in Parks/Playground: move mouse pointer to column L.
Starting at the row below the column description, in reference to column B {name of
municipality) select the data you would like to update and type the new value.

Number of Unsanitary Toilets in Parks/Playground: move mouse pointer to column
M. Starting at the row below the column deseription, in reference to column B (name
of municipality) select the data you would like to update and type the new value.

click the tab of (M) Prainage Facility sheet,

Length of Drainage Maini: move meuse pointer to column C. Starting at the row

- below the column description, in reference to column B (name of municipatity) select
. the data you would like to update and type the new value.

Length of Open Chanuel (with concrete and masenry): move mouse pointer to
column D. Starting at the row below the column description, in reference to column
8 (name of municipality) sclect the date you would like to update and type the new
value. ;

- Length of Open Ditehes And Unlined Laterals: move mouse pointer to column E.

Starting al the row below the column deseription, in reference to column B {name of

* municipality) select the data you would like to update and type the new value.

Length of Reir{forced' Concrete Circular Pipes: move mouse pointer to colurn F.
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

Length of Street Guiters: inove mouse pointer to column G. Starting at the row

- below the column description, in reference to column B {name of unicipality) select

the data you would like to update and type the new value.

Length of Outfalls To Rivers From Drainage Mains: move mouse pointer 1o
cotumn H. Starting at the row below the column description, in reference to column
B (name of municipality) select the data you would like to update and type the new
value. ' '

click the tab of (M} Solid Waste sheel.

Number of Open Dump Trucks: move mousc poiﬁlcr to column C. Starting at the
row below the column descripiion, in reference to column B (name of municipality)
select the data you would like to update and type the new value.
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8.7.

o Number of Closed Type Trucks: move mouse pointer to column D. Starting at the
row betow the colemn description, in reference to column B (name of municipality)
seleet the data you would like to update and type the new value.

o Number of Households Served By Open Dump Sile: move mouse pointer to columin
F. Starting at the row below the colunmn description, in reference to colunn B (name
of municipality) sclect the data you would fike to update and type the new value.

s Number of Households Served By Sanitary Landfill: move mouse pointer (o colunmmn
G. Starting at the row below (he column description, in reference to columa B (name
of municipality) select the data you would like to update and type the new value.

s Number of Houscholds Depending on Dumping on Land or Water: move mouse
pointer to column H. Starting at the row below the column description, in reference
to column B (name of municipality) select the data you would like to update and type
the new value.

o Number of Households Depending on Burying: move mouse pointer to column L
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and typé the new value.

¢ Number of Houselolds Depending on Composting: move mouse pointer to column
). Starting at the row below the calumn description, in reference to colamn B (name
of municipality} select the data you would like to update and type the new value.

. Upd:iting Investment PData Base

1. Click the Kile menu, sclect Open,
Short-cut: Click the Open button.

2. From the Open Dialog Box. Select the invest.xls ftlemmc
3.1 To update the Past Investment Data,

click the tab of (P) Past fnvest sheet.

s Shallow Well: move mouse pointer to column C, Starting at the row below the
column description, in reference to colvmn A (name of funding agency) select lhe
data you would like to update and type the new value,

e Deep Well: move mouse pomtu to column I}, Starting at the row below the column
description, in reference to column A (name of funding agency) select the data you
would like to updale and type the new value.

o Spring Development: move mouse pointer to column E. Starting at the row below
" the columa description, in reference to column A {name of funding agency) select the
- data you would like to update and type the new value,

o Well Relabilitation: move mouse pointer to column F, Stan_ing at the row below the
column description, in refecence to column A (name of funding agency) select the
data you would tike 1o update and type the new value.

e Rain Collector: move mouse pointer to column G. Starting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would tike to update and type the new value.

o Level II System: move mouse pointer to column H. Starting at the row below the
column description, in reference 1o column A (name of funding agency) select the
data you would like to update and type the new value.
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e [Level 1T System: move mouse pointer to column L Starting at the row below the
column description, in reference to column A (name of funding agency) sclect the
data you would like to update and type the new value,

o Sewer Sysfem: move mouse pointer to column i, Starting at the row below the
column description, in reference to column A {(name of funding agency) select the
data you would like to update and type the new value.

-—

e Private Latrines: move mouse pointer to column K. Staiting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like 1o update and type the new value.

e School Toilets: move mouse pointer to column L. Starting at the row below the
column description, in reference to colomn A (name of funding agency) select the
data you would like to update and type the new value.

e Public Toilets: move mouse pointer to column M. Starting at the row below the
column description, in reference to column A (name of funding agenicy) select the
data you would like to update and type the new value.

3.2 To update the Planned Futare Investment Dala
click the tab of (P} Future Invest sheet.

o Praject Name: move mouse po_in_tér to column A. Starting at the row below the
column description, type the project identification. o

o Type of Praject: move mouse pointer to column B. Starting at the row below the
column description, in reference to column A (name of project) type the new value.

e  Phase of Project: move mouse pointer to column C. Staiting at the row below the
column description, in reference to column A (name of project) type the new value.

e Project Location: move mouse pointer to column D. Starting at the row below the
- column description, in reference to column A (name of project) type the new value.

o Implementing Agency: move mouse pointer to column E. Starting at the row below
the column description, in reference to column A (name of project) type the new
value, '

o Start Date of Project: move niouse pointer to cofunm . Starting at the row below
the column description, in reference to coluimm A (mane of project) type the new
value. '

o Cowmpletion Date of the Project: move mouse pointer to column G. Starting at the
row below the column description, in reference to column A (rame of praject) lype
" the new value. ' .

o Accomplishiment Status (%); move mouse pointer to colmunl_}{ Starting at the row
below the column description, in reference to column A (name of project) type the
new value. : :

o Number of Household Covered by the Prajeei: move mouse pointer to columa L.
Starting at the row below the column descri plion, in reference to column A (name of
project) type the new value.

o Finance Agency: move mouse pointer to colamn ). Stasting at the row below the
column description, in reference to column A (name of preject) type the new vatue.
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3.8.

Cost of Level I Facilily (Thousand of pesos): move mouse pointer to column K.
Starting at the row below the column description, in reference to column A (name of
project) type the new value.

Cost of Level 11 Systemn (Thousand of pesos): move mouse pointer to column L.
Starting al the row below the columa description, in reference to column A (name of
project) type the new value.

Cost of Level 111 System (Thousand of peses): mave mouse pointer to column M.
Starting at the row below the column de unpllon in reference o column A (name of
project) type the new value.

Cost of Sewer System (Thousand of pesos): move mouse pointer to column N,
Starting al the row below the column deseription, in reference to column A (name of
project) type the new value.

Private Latrine (Thousand of pesos): move mouse pointer to column Q. Starting at
the row below the column description, in reference to column A (name of project)
type the new value.

Cost School Toilets (Thousand of pesos): move movuse pointer to column P. Starting
at the row below the column description, in reference to column A (name of project)
type the riew value.

Cost of Public Toilets (Thousand of pesos):_ nove mouse peinter to column Q.
Stacting at the row below the column description, in reference to column A (name of
project) type the new value.

" Updating Key Parameter Data Base

. Click the File menu, select Qpen.
Short-cut: Click the Open button.

~ 2. From the Open Dialog Box. Select the Ae}par xlv filename.

3. To update the Key Parameter Data,
click the tab of STable 2.6.2 sheel.

 Water Supply: '

s Number of Houselold to bf'_ Served by Level I Facility: move mouse pointer to
colunm H-Row S. Type the new value. '

*  Water Cousumption Rafe for Level H! System: move mouse pointer to column H-
Row 6. Type the new value.

Sanitation:

o Standard Number of Student to be Served by a Unit of Sanitary Toilel: MOVe mouse
pointer to column H-Row 8. Type the new value.

R

Standard Number of Toilets for Public Facility: move mouse pointer to columa H-
Row 9. Type the new value,

Medinmn-term Plan:

Percentage of Population Covered by Urban Water Supply: move mouse pointer to
colunmn H-Row 11. Type the new value.

Percentage of Population Covered by Rural Water Supply: move mouse pointer to
column H-Row 2. Type the new value.
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Percentage of Population Covered by Sawnitary Toilet: move mouse potnter to
colunmin H-Row 14. Type the new value.

Percentage of Urban Household Covered by Flush Toilet: move mouse pointer to
colunm H-Row 16. Type the new value.

Percentage of Urban Houseliofd Covered by Pour Flush Teilet: move mouse
pointer to column H-Row 17. Type the new value.

Percentage of Urban Household Covered by VIP Latrine: move mouse pointer to
column H-Row 18. Type the new value.

Percentage of Rural Househaold Covered by Flush Toilet: move mouse pointer to
column H-Row 20. Type the new value.

Percentage of Rural Household Covered by Pour Fiush Toilet: move mouse pointer
to column H-Row 21. Type the new value.

Percentage of Rural Household Covered by VIP Latrine: move mouse pointer to
column H-Row 22. Type the new value,

Percentage of Public Student Covered by School Foilet: move mouse pointer (o
column H-Row 23. Type the new value.

Percentage of Public Ulility Covered by Public Toilet: move mousc pointer to

" column H-Row 24. Type the new value,

Percentage of Population Covered by Solid Waste Collection: ‘move mouse pointer
to column H-Row 25, Type the new value. : '

fong-term Plan:

Percentage of Papulation Covered by Urban Water Supply: move mouse pointer to

-column H-Row 27. Type the new value.

Percentage of Population Covered by Rural Waler Supply: niove mouse pointer to

column H-Row 28. Type the new value.

-Percentage of Population Covered by Sanitary Tolfot MOVE Mouse pointer 1o

column H-Row 30. Type the new value.

Percenrage af Urban Househeld Covered by Flush Toilet: move mouse pointer (o
colurn H-Row 32. Type the new value.

Percentage of Urban Houschold Covered by Pour Fiush Toilet: move mouse
pointer to column H-Row 33. Type the new value.

" Percentage of Urban Household Covered by VIP Latrine: move mouse pointer (o

column H-Row 34, Type the new value.

Percentage of Rural Household Covered by Flush Toilet: mave mouse pointer o
column H-Row 36. Type the new value.

Percentage of Rural Household Covered by Pour Flush Toilel: move mouse pointer
to columa H-Row 37. Type the new value.

Percentage of Rural Household Covered by VIP Lafrine: move mouse pmmer g
column H-Row 38. Type the new value,

Percentage of Public Student Covered by School Toilet: move mouse pointer to
cotumn H-Row 39, Type the new value.
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s Percentage of Public Utility Covered by Public Teifet: move mouse pointer to
column H-Row 40, Type the new value,

¢ Percentage af Population Covered by Urban Sewerage: wmove mouse poiater to
column H-Row 41, Type the new value.

Rehabilitation:

o Percentage of Level I Wells for Rehabilitation: move mouse poiater to coluina H-

Row 42, Type the new value.

Sectar Management Cost:

o Percentage of Feasibility and Detail Design: move mouse pointer to column H-Row
44, Type the new value.

o Percentage of Construction Supervision: move mouse pointer to column H-Row 45.
Type the new value.

Contingencies:

e Percentage of Physical Confingency: move mouse pointer to column H-Row 47.
Type the new value. :

o Percentage of Price Contingency: move mouse pointer to column H-Row 48. Type

the new value. :

e Contmuiiity Development and Training Cost:

Percentage for Level 11 System: move mouse pointer to column H-Row 50. Type
the new value. : ‘ :

Percentage for Level I Facility and Level I System: move iouse pointer to column

- H-Row 51. Type the new value.

Recurrent Cast:

L ]

- Opemﬁhg Cost for Level 111 System: move mouse pointer o column H-Row 52.

Type the new value.

Cost of Spare Parts/Equipment for Level HI Sysfem: move mousc pointer to
columin H-Row 53. Type the new value.

Cost of Spare Par!s/Eqm'p.fnem Jor Level 1 System: move mouse poiiter o column

" H-Row 54. Type the new value.

Cost of Spare Parts/Equipment for Level 1 Facility: move mouse poinicr to column
"~ H-Row 35. Type the new value.

Public School Toilet Maintenance Cost: move mouse pointer to column H-Row 56.

" Type the new value.

Public Utility Toilet Maintenance Cost: move mouse pointer to column H-Row 57,
Type the new value,
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Allecation Factors/Percentages of IRA:

o Percentage Share from Provincial IRA: move mouse pointer to column H-Row 59.
Type the new value.

o Percentage Share from Municipal/Barangay IRA: move mouse pointer lo colamn
H-Row 60. Type the new value.

Funding Levels/Percentages for Different Financing Seenarios:
s Ist Scenario: move mouse pointer to column H-Row 62. Type the new value.
e 2nd Scenario: move mouse pointer to column H-Row 63. Type the new value.
s 3rd Sceitario: move mouse pointer to column H-Row 64. Type the new value.
"o 4th Scenario: move mouse pointer to column H-Row 65. Typé the new value.

o  Sth Scenario: move mouse pointer to column H-Row 66. Type the new value.
click the tab of STable 2.6.3 shect:

o Percentage Proportion of Water Source: move mouse pointer to column D. Starting -

at the row below the column desciiption, in reference to column- A (name of

- municipality), column B (type of area), column C (type of sourc c) select the data you
would like o update and type the new value. :

% : * . Range Depth of Well: move mouse poiater to LO!U]]IR E. Starting at the row below
’ - the column descriplion, in reference to column A (name of municipality), column B
(type of area), column C (type of source) su!ect lhe data you would like to update and
type the new value.

o Average Specific Capacity: move mouse pointer to column F. Starting at the row
below the column description, in reference to colunn A {name of municipality),
column B (type of area), column C {type of source) sdecl the data you would like to
update and type the new value. '

cl1ck the tab of STable 2.6.5 sheet.

o Unsafe Percenragf move mouse pointer to column C. Starting at the row below the
column description, in reference to column A (name of muhicipality) select the data
you would like to update and type the new value.

click lh_e tab of STable 2.6.6 shecet.

e Unit Construction Cost for New Level 111 System for 5,000 population: move
mouse pointer to column B-Row 7. Type the new value.

o Unit Construction Cost for New Level 111 System for 10,000 population: wmaove
mouse pointer to column B-Row 8. Type the new value.

g o Unit Construction Cost for New Level IH System for 15,000 population: wove
mouse pointer to column B-Row 9. Type the new value.

¢ Unit Construction Cost for Level 11 Sysiem Expansion Jor 5,000 population: move
mouse pointer to column B-Row F1. Type the new value.
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Unit Construction Cost for Level 11 Systemn Expausion for 10,000 population:
move mouse pointer to colomn B-Row 12, Type the new value.

Unit Construction Cost for Level Il System Expansion for 15,000 population:
move mouse pointer to column B-Row 13, Type the new value.

Unit Construction Cosi for Level 11 System: move mouse pointer to column B-Row
14. Type the new value.

Unit Construction Cost for Level § Facility (Deep Iell - 40 meter depth): move
mouse pointer to column B-Row 16. Type the new value,

Unit Construction Cost for Level I Facility (Deep Well - 80 meter depth): move
mouse pointer to column B-Row 7. Type the new value,

‘Unit Construction Cost for Level I Facility (Deep Well - 120 meter deptli): move

mouse pointer to column B-Row 8. Type the new value.

Unit Construction Cost for Level [ Facility (Shatiow Well): move mouse pointer lo
colomn B-Row 19, Type the new value.

Unit Construction Cost for Rehabilitation of Level I Facility: move mouse pointer
to column B-Row 20. Type the new value.

Cest for Disit:j'édion of Level 1 Wells: move mouse pointer 1o coluimn B-Row 21,

Type the new value.

Unit Construction Cost for Flush Toilet: move mouse pointer to colwmnn B-Row 22. .

Type lht. new value.

Unit Canstruction Cost for I’our F 1'ush Toilet: move mouse pmnter to column B-

© Row 23 Type the new value,

Unit Conslmcrron Cost for VIP Latrine Toilel: move mouse pointer to column B-
Row 24, Type thc new value.

Unit Construction Cost for School Toilet: move mout;e pointer 1o column B- Row
25. Type the new value.

Unit Construction Cost for Public Toilet: move mouse pointer ta column B-Row 26.
Type the new value.

- Unit Construaction Cost for Urban Sewerage: move mouse pointer to column B-Row

27. Type the new value.

click the tab of STable 2.6.4 shect.

Urban Water Supply (Level HI System):

»

Feasibility Study and Detail Design: move mouse pointer to Roew 6. Stanting at
Columin F (Year 1996) up to Column J (Year 2000) select the data you would like to
update and type the new value,

Construction and Supervision: move mouse pointer to Row 7. Starting at Colunn FF
(Yecar 1996) up to Columin J (Year 2000) select the data you would like to update and
type the new value,

Conumnunity Development and Training: move mouse pointer to Row 8. Starting at
Column ¥ (Year 1996} up to Column J (Year 2000) select the data you would like to
update and type the new value.
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Rural Water Supply (Level I Facility):

Petail Design: move mouse pointer to Row 10. Statting at Column ¥ (Year 1996) up
to Column J (Year 2000) sclect the data you would like to update and type the new
value.

Construction and Supervision: move ntouse pointer to Row 11, Stanting at Column
F (Year 1996) up to Column I {Year 2000) select the data you would like 1o update
and type the new value,

Community Development and Training: move mouse poinier {o Row 2. Stasting at
Column F (Year 1996) up to Column J (Year 2000) select the data you would like to
update and type the new value.

Rural Waiter Supply (Level 1 Systemn}.

*

Detail Design: move mouse pointer to Row 14. Starting at Column F (Year 1996) up
to Coluinn J {Year 2000) select the data you would like to update and type the new
value.

Construction and Supervision: move mouse pointer to Row 15. Starting at Column
F (Year 1996) up to Column J (Year 2000) sclect the data you would like to update
and type the new value.

- Community Development and Training: move mouse pointer to Row 16. Starting at

Colunm F (Year 1996) up to Colomn J (Yedr 2000} select the data you -.\ould like to
update and type the new value.

Sanitation:

Urban Household Toilet: move mouse pointer to Row-17. Statting at Column F
{Year 1996) up to Column J (Year 2000) select the data you would like to update and
type the new value.

Raral Household Toilet: move mouse pointer to Row I8 Starting at Column F
{Year 1996) up to Column J {Year 2000) select the data you would like to llpd'llt‘: and
type the new value,

Public School Toilet: wmove mouse pointer to Row 19, Starting at Column F (Year
1996) up to Column J (Year 2000) select the data you would like to update and type
the new value.

Pablic Toilef: move mouse pomler to Row 20. Stasting at Column F (Year 1996) up
to Column J (Year 2000) select the dala you wonld hke to update and lype the new
value.

Disinfection of Level I Wells: move mouse pointer to Row 21. Starting at Column F
(Year 1996) up to Column J (Year 2000) select the data you would like to update and
iype the new value.

Detail Design: move mouse pointer to Row 22. Starting at Column F (Year 1996) up
to Column § {Year 2000) select the data you would like to up(hlc and type the new
value.

Constriction and Supervision: move maouse pointer to Row 23. Starting at Column
F (Year 1996) up to Column J (Year 2000) sefect the data you would hike to update
and iype the new value.
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e - Canununity Peveloprient and Training: move mouse pointer to Row 24. Starting at

Column F (Year 1996) up to Cohunn J (Year 2000) select the data you would like to
update and type the new value.

click the tab of STable 2.6.7 & 2.6.8 sheel.

Scoring Factor for Municipal Investmeitt Ranking for Urban Water Supply:

]

Minimun Percentage of Underserved and Unserved Population in Base Year: move
moeuse pointer to column B, in refercnce to column A (score) select the data you
would like to update and 1ype the new value.

Muaximum Percentage of Underserved and Unserved Population in Base Year: move
mouse pointer to column D, in reference to column A (score} select the data you
would tike to update and type the new value.

Weight Allocation Score for Underserved and Unserved Population in Buse Year:
move niouse pointer to column C-Row 9. Type the new value.

Minimin Percentage of Underserved and Unserved Population in Phase I move
mouse peointer to column E, in reference o column A (score) bLiL’Cl the data you
would like to update and type the new value.

Maximu Percentuge of Underserved and Unserved Population in Phase I move

* mouse pointer to column G, in reference to column A {score) select the data you

would like to update and type the new value.

Weight allocation Score for Underscived and Unserved Population in Phase I move
mouse pointer to column F-Row 9. Type the new value.

' Mim'mmi Percentage of Underserved and Unserved b y Level 111 Sysréu.' in the Base

Year: move mouse pointer to column H, in reference to column A (score) select the
data you would like to update and type the new value.

Maximum Percemciee of of Underserved and Unserved by Level IHI System in the
Base Year: move mouse pointer to column J, in reference to column A {\core) select

- the data you would like to update and- type the new value.

Weight Allocation Score for Underserved and Unserved by Level m Systenr in the
Base Year: move mouse pointer to column I-Row 9. Type the new value.

Scoring Factor for Municipal Comprehensive Investinent Ranking:

Minimun Percentage of Rural Water Supply: move mouse pointer to colunm £, in
reference to column A (score) at starting at row 13, sclect the data you would like to

~update and Lype the new value,

- Maximum Percentage of Rural Water Supply: move mouse pointer to column G, in

reference to column A (score) at starfing at row 15, select the data you would like to

update and type the new value.

Weight Aflocation Score for Rural Water Supply: move mouse pointer to column F-

~ Row 20. Type the new value.

Minimun Percentuge of Urban Sanifalion: move mouse pointer to column H, in
refetence to column A (score) at starting at row 15, select the data you would like (o
update and type the n2w value,
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8.9.

3.9.1.

Maximun Percentage of Urban Sanitation: move mouse peinter to column J, in
refercnce to column A (score) at starling at row 15, select the data you would like to
update and §ype the new value.

Weight Aflocation Score for Urban Sanitation: move mouse pointer to columm |-
Row 20. Type the new value.

Minimun Percentuge of Rural Sanitation: move mouse pointer to column K,
reference to column A (score) at starting at row 15, select the data you would Il'\b to
update and type the new value.

Maxinumi Percentage of Rural Sanitation: move mouse pointer to column M,
reference to column A (score) at starting at row 15, sc[eul the data you would llkL to
update and type the new value.

Weight Allocation Score for Rural Sanitation: wmove mouse pointer to column L-
Row 20. Type the new value.

Updating Unit Construction Cost Data Base

Water Supply

1. Click the File menu, select Qpen.

Short-cut: Click the Open button. _ _
2. From the Open Dialog Box. Select the chap-10.4ls filename.
3.L.To update the Unit Cost for Level ITI (5,000 popu!atlon)

click the tab of §Table 10.2.7 sheet.

Quantify: move mouse pointer to column C. Starting at the row below the column

- description, in reference to column B (item deﬁcnpuon) select the data you would

like to update and type the new value.

Unit Cost: move mouse pointer to column E. Starting at the row below the column

~description, in reference to column B (item description) select the data you would .
- dike to update and type the new value.

3.2To update the Unit Cost for Level 1H (10,000 population),
click the tab of STable 10.2.8 sheet.

Quantity: move mouse pointer to column C. Starting at the row below the column
description, in reference to column B (item descrlpllon) select the data you would -
like to updale and type the new value. :

Unit Cost: move mouse pointer to colimn E. Starting at the row below the column
description, in reference to column B (item deﬁcnphon) select the data you would
like {0 update and type the new value,

3.3.FTo update the Unit Cost for Level 111 (15,000 population),
click the tab of STable 10.2.9 sheet.

QGuantity: move mouse painter to column C. Statting at the row below the column
description, in reference to column B (item description) select the data you would
Iike (o update and type the new vafue.
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e Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, in reference to column B (item description) select the data you would
tike to update and type the new value.

3.4.To update the Unit Cost for Level 11 (600 population),
click the tab of STalble 10.2.6 sheel.

e Lumnp Cost of Spring Box: move mouse pointer to column G-Row-4. Type the new
vitlag. '

o Quandity of Iustallotion of Pipelines and Fittings: move mouse pointer to coturmn D.
Starting at the row below the column description, in reference to colunn B (item
description) select the data you would like to update and type the new value.

s Unit Cost of Installation of Pipelines and Fittings: move mouse pointer to column
I%. Starting at the row below the column description, in reference to colunm B (item
description) select the data you would like to update and type the new value.

3.5.To update the Unit Cost for Level [ (Deep Well - 40 m depth),
click the tab of STable 10.2.1 sheel.

o Lump Sum Cost of Mobilization/Demobilization: move mouse pointer to colunm F-
Row-4. Type the new value.

s Quantity: move mouse pointer to column C. Stating at the row. below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value.

*  Unit Cost: move mouse pointer to column E. Starting at the row below the column
Ny description, in reference to columa B (item description) select the data you would
fike to update and type the new value.

3.6.To update the Uml Cost for Level I (Deep Well - 80 deplh}
click the tab of STuble 10.2.2 sheet.

o Lump Sum Cost of Mobilization/Demeobilization: ymove mouse pointer to column F-
Row-4. Type the new value.

*  Quaniity. move mouse pointer to column C. Stating at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value.

¢ Unit Cost: move mouse pointer to columa E. Starting at the row below the column
~ description, in reference to column B (iteny desceiption) select the dax you would
like to update and type the new value.

3.7.To update the Unit Cost for Level T (Deep Well - 120 wm depth),
“click the tab of STable 10.2.3 sheet.

o Lump Sum Cost of Mobilization/Demobilization: move mouse pointer to column I
Row-4. Type the new value,

o Quantity: move mouse pointer to column C. Starting at the row below the column
description, in reference to column B (item description) select the data you wonld
like to update and type the new value.
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8.9.2.

o Unit Cost: move mouse pointer to column . Starting at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value.

3.8.To update the Unit Cost for Level I (Deep Welt Rehabilitation),

click the tab of STable 18.2.4 sheet.

o Lump Sum Cost of Mebilization/Demobilization: mave mouse pointer to column F-
Row-4. Type the new value.

o Quantity: move mouse pointer lo column C. Starting at the row below the colwmn
description, in reference to column B (item description) select the data you would
like to update and type the new value,

e Unit Cosi: move mouse pointer to column E. Starting at the row below the column
. description. in reference to column B (item description) sefect the data you would
like to update and type the new value.

3.9.To update the Unit Cost for Level I (Shaliow Well - 18 m depth),
click the tab of STable 10.2.5 sheet.

o Lump Sum Cost of Mobilization/Demeobilization: move mouse pointer to column F-
Row-4. Type the new value, i

» * Quantity: move mouse pointer to column C. Starting at the row below the columa
~ description, ‘in reference to column B (item description) select the data you would
like to updale and type the new value.

e Unit Cost: move mouse pointer to co!umn i Stanting at the row below the column
description, in reference to column B {item dt.SCl’IpllOﬂ) select the data you would
like to update and type the new value.

l*)m'iroume'n!al Sanitation

1. Click the Fife menu, select Qpen.
Short-cut: Click the Open button.
2. From the Opren Dialog Box. Select the chap-10.x!s filenanie.
3.1.To update the Unit Cest of ¥Flush Water Scaled Teilet with Septic
click the tab of STable 10.2.10 sheet.

. Quanfity: move mouse pointer Lo column C. Starting at the row betow the columin
description, in reference to column B (item’ dc\cnpuon) select the data you would
like to update and fype the new value,

o' Unit Cost: move mouse pointer to columit E. Starting at the row below the column
* description, in reference to column B (item description) select the data you would
like to update and type the new value,

3.2. To update the Unit Cost of Pour Flush Toilet with Double Pit Latrine

click the tab of STable 10.2. 11 sheet,

e Quantity: move mouse pointer to column C. Starting at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value.
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o Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, in reference to column B (item description) sclect the dita you would
like to update and type the new value.

3.3, To update the Unit Cost of Ventilated Improved Pit Latrine (VIP)
click the tab of STable 10.2.12 sheet.

e Quantity: move mouse pointer to column D. Stating at the row below the column
description, in reference to column C (item description) select the data you would
like to update and type the new value.

o Unit Cost: mave mouse pointer to column H. Starting at the row below the colomn
description, in refererice to column C (item description) select the data you would
like to update and type the new value.

3.4.To update the Unit Cost of School Toilet
click the tab of STable 10.2.13 sheet.

¢ Quantity: move mouse pointer to column D. Starting at the row below the coluwmn
description, in reference to column C (item description) select the data you would
like to update and type the new value.

e Unit Cost: move mouse pointer o cotumn H. Starting at the row below the column
description, in reference to column C (item description} select the data you would
like to update and type the new value,

© 3.5.To update the Unit Cost of Public Toilet
click the tab of STable 10.2.14 sheet.

‘s Quantity: move mouse pointer to column D. Stasting at the row below the colunn
description, in reference to column C (ilem description) select lhe data you would
like to update and type the new value, : '

e Unit Cost: move mouse pointer to column H. Starting at the row below the column

description, in reference to column C (item description) select the data you ‘would

like to update and type the new value.
9, Standard Report Format

The following page describes the standard report format. Please refer to MS-Word Basic

Operation in Section 5 for procedure in setting the MS-Word environment.
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Specification for Standard Report Format

Edge of paper. Title of section -
//
4. EXISTING FACILITIES AND SERVICE COVERAGE=
4.1 Water Supply ~s -~ —--Sub-section
/ Textbox - — — - »f
4.2, General == - _ _

- ——----»-I---—- — st indent - 0.5"

All around margin - "

This is an emmplc output of the main text.

o Spacing beiween paragrpakh - 1 blank line.

Type and composition of water supply facilities are classified into
three service levels based on the definition given in the National
Sector Master Plan and presented in Table 4.1.1. Various types of '
Level 1 Facilities/sources defined to safe and unsafe sources by DOH.
This classification adopted for peeparation of PWASP does not
disregard the facts that the existing improved/covered dug well is
sometimes yielding non-potable water.

(1} Problem areas
l--{ - 2nd indent - 0.25”

Problem areas are identified through review of lhc exsiting water
supply facilities and countermeasures and recommendations for
their improvement aré prepared to retlect on the future planning in
Pw4sP. '

1) Level I facilities

Comments on éach sub-title _shal!__[:_m; followed in the manner
‘as shown herewilh.

- Line spacing - 1.5 line.
1 Driven sha!low wells

;\msl of driven shatlow wells are exposed lo dmg-.r nl
polluuon through scepage of surface water.

- 3rd |'r:dem L 0.25"
— th indent - 0.25"

Standard seitings;

Standard Fent - New Roman Times.

FFont Size 11 points.

Paragraph - Justified alignment.

Title of Section - Bold Font, All Upper Case.
Sub-Section - Bold Fom, First Letter Upper Case.

c—- - Alt around margin - 1"
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Kcey Parameter

No. Description of Key Parameter Unit Values
1. .. |Weter Supply
4 Number of household to be senved by Level { Focility HHMWel
'-3 Water Conmrnpt:on Rate for Level 1l Syslem Liter/capita/day
% Sanitation
2 Std. number of studeat to be served by a unit of sanitary toilet Swdent/Toilet
Standand pinber of loilets for a public un‘h[y _ ToilsUPublic Fauhiy
2. Woter Supply .
UrbanWater Supply % of Population
Rural Water Supply <% of Population
Sanitation _
g Heusehold Toiket % of Nouschold
~ U!ban Houte?o!d Torfa_ ] ]
£ Flush ) % of Houschotd
& Pour Flush’ % of Household
5 ViP Latsine . 7 % of Household
2 Rural Ho.ueho{d Tv;!e.r B
T Flush ) % of Household
s | = Pour Fush % of Houschold
L VIPLatine % of Household -
[l School Toilet " % of Publiic 51 udent
g Public Toitat % of Public Utility
A Solid Waste % of Population
i Waler Supply .
-g UrbanWater Supply % of Population
8 Rusal Water Supply % of Population
2 Sanitation ’
& Househotd Toilet o % of Mouseheld
' ] Urban Household Tonler
> Flush - % of Houschold
g Puur Hu sh % of Household
B VIP Fatrine % of Household
o Rucul H('u.sth("d' Tm’tl‘ o
3 Flush % of Houschotd
Pour Hush % of Houschold
VIE thn-n: %% of Househo!d
School Toilet % ol' Public Student
Public Toi} o o % of Public Utility
Urban Sewerage : % of Urban Population
3. |Percentage of Level I Wells for Rehabxmauon %
4. [Percentage of Sector Management Cost lo Constrnclwn Cost
Feasibility and Detail Design % of Construction Cost
Construction Supervision % of Construction Cost
5 [Contingencies
Physical Contingeacy % of Construction Cest
Price Contingency Pefcent per annum
6. ('ommumt} Devclopment and Training Cost -
Level il % of Construction Cobst
‘ Levelsd and Il % of Construction Cost
A % Level NI System {Operating Cost) Pesos/t/year
.0 |Levet UL System (Spare Parts/Equipment) % of Construction Cost
B |Levet 1 S)ﬂlem (Spare Part/Equipment) Pesos/Htyear
‘ § Level System (Spare Pats/Equipment) Pesos/HH/year
2 |Public Schoot Toiket Maintenance Cost Pesos/Teiletyear
: % |public Uuhly Tetlel Maintenance Cast PesosToiletyear
8. JAllocation factors¥ercentages of IRA
From Provincial %
: From Munic tpahly and Brgy %
9. [Funding Levels/Percenatges for Different hnandng Scenarios
Fst Scenario % Funding Available
2od Scenario % Funding Available
Xd Sceaario % Funding Availatle
4th Scenario % Funding Available
Sth Scenario % Funding Available ]

2- 166



Composition of Well Sources and Specific Capacity

Standard Specification
Municipality Area Source Proportion| Depth SWL Specific Capacity
{%) (ny) {m) flit'secfm) |
Rural Shallaw Wel!
Deep Well
Urban Shallow Well
" Deep Well
Rural Shatlow Well
Deep Well
Urban Shaltow Well
Deep Well
Rural | Shallow Well .
Deep Well
Urban Shatlow Wl
Deep Well
Rural Shalkewy Well
Dcep Well
Urban Shallow Weil
Peep Well ]
Rural Shallow Well
Deep Well
Usban|  shallow Well ]
Deep Yell
Rural Shahlow Well
Deep Well
Urban |  Shallow Well |
Deep Well —
Rural Shallow Well
Deeg VWell ]
Urban Shallow Well
Deep Welt ]
Rural | Shaliow Welt ]
Deep Wl
Ueban]  Skatlow Well
Beep Well
Raral | shallow well
Deep Well
Urban|  Shallow Well
Derp Well
Rural | . Shallow Weli
Deep Well
Urban Shallow Wil
Deep ¥rell
Rural Shallow Welt B
Deep Well
Urban Shatlow Well
R Decp Well
Rural Shaltow Well
Deep Welt -
Urbanl _ shatlow wen L
| Deep Wel L
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Annual Distribution of Investment Cost Required by Sub-sector

for Medivm-term Development Plan
Unit: Percent .

Sub-Secctor Component 1996
e L Level I System
3 g ‘é Feasibility Study and Detail Desiga
S22 Coastruction & Supemslon
Cﬂmmum\y D:.\ciopmcnt & Tmrmg
Level I Facility
b Detail Design
B o Construction ‘_&_$upgmsmn o
-y Community Development & Tralmng
i g‘ Level H Systemn
; v Detail Design
o4 Cons!:ucuon & Supuusmn )
Commumty Development & Training
Urban Household Toilel
Rural Household Tmlel
g Pubhc Schooi T m]e{
'g Public Toilet
‘B Disinfection of Level  Wells -
2 Detail Design
Consu on & Supemston
Communny Dev elopment & Trsinin 2

Level 1 Safe and Unsafe Percentage

e Safe Source Unsafe Source
Municipality (%) “

Provincial Average

i
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3.

& 3.2

PROVINCIAL PROFILE
Natural Conditions and Geographical Features

323 Topography and Drainage

Table 3.2.1 Flow Data of Major Rivers

RIVER = ABRARIVER LOCATION = BANAOANG, BANTAY,ILOCOS SUR
" OSTAID = O01SWI3202R004 LATITURE = 1733 2}
AGENEY = BPFW-OFWH, BAS LONGITUDE = 120 28 30
DRAINAGE AREA (SO KM) = 4813 ELEV OF ZGAGE = 3.15M.ABOVE MSL
GAGE TYPE = NA GAGE OPERATION = STAFF GAGE READSIX A DAY
START O8SERVATION = HOV 1958 STATUS = NON-OPERATIONAL
083 LAST CONSIDEAED = NOV13T? AEMARKS = RECORDS ARE FAIR

A ANNUAL OISCHARGE CHARACTERISTICS (Q IRCU M/SEQ)

YOR PEIAK GAGEHT. DATE  TIME BAXDLY MEAN MINDLY GAGEKT  OATE RUNOFF
Q@ {MEERS) Q Q Q  (MEHRS) WM
T N0 500 e ST 228 ORCAE et
972 434080 708 JULY 49180 43154 5180 L9b ARR2E 28353
1972 38000 700 OCLI7 1ZEN 232600 2840 3670 132 - ARRZE 14323
1974 40000 720 OCLIZ 128N 183000 vttt 4080 216 APROLtettt
K15 81200 435 SEPO  O8AM 79500 13101 3750 180 ARRDZ 6598
%‘ W76 475300 TS0 JLOL 12NN 440800 17997 370 182 - ARR2R MUt
O WT 4000 - LI0C SERI9 0SPM 34400 ctttt 2300 RS0 ARRDL T
(. MEAN MONTHLY DISCHARGE IH (U M/SECOND
YO TAN WK APR WAY JOR_ JoL _ AUG  Sep OCF KoV O
713200 8169 1849 I03 1R0s0 2937 W0D20 52609 1687 95808 0 18530
1970 18698 11273 8578 - S991 11831 IWJ3 W49L0 103470 316I0 0LS 270 1N
91 41% N BB A4St SIS 8381 2531 4K 102650 41607 13045
1978 4452 et tveet g1 4895 30547 6085 $9695 - 42083 et cenet o T
075 19240 3901 19 3809 4540 MY T4 7358 HAN 3097 4361 AL
976 4120 3997 3852 728 56010 19238 57445 24148 W8N 10502 5138 5282
97 4320 4059 934 9 962 14035 20222 6071 109940 4268 a3 TUtTY

sxess HDICATES MISSING DATA, NOT INCLUDLO 1N CALCULATIGH OF STATISTICAL PARAMETERS



AIVER = STA.MARIA RIVER LOCAYION = NO.2SABANGAN-PINGAN, BURGDS, ILOCOS SUR

STAID = DISWITIZ03PW00I LATITUDE = 12 16 &7
AGENMCY = BFW-OFWH,EBRS LOKRGITUDE = 120 31 14
DRAINAGE AREA{SC XM} = 123 ELEV OF ZGAGE = 1729 M. ABOVE M5L
GAGE TYPE = HR GAGE OFPERATION = STAFF GAGE READS3X A DAY
START OBSERVATION = FEB 1857 STATUS = NON-OPERATIONAL
-

08S LAST C0ONSIOERED SEP 1977 AEMARKS = RAECOADS ARE FAIR

A ANKUAL DISCHARGE (HARACTERISTICS (QINCU W S€C)

YEAR  PEAK  GAGEHT. OATE  TIME  MAXDLY MEAN MINOLY GAGEHT DAIE  RUNOIF
0 (MEIERS) Q q 0 (METERS) MM
i 1w 10 JUN-Td 980035 001 03 KP4
|9?2 VSRS 19808 . [T 20N EERE Y] St aybhox . saada
1573 4500 180 OCT08 0AM 4370 208 001 020  MAR 529
1974 85 050  FEB-O1  OSPM 4305  tt*  00) 00 JAN28  tecre
1975 125 320 AUGIZ  O4AM 1208 ettt 002 09 MAY.2§ veet

Ig?s sLsedy L2 N3 qetes LR L [ LEER ] XX 22 sesky

I3 425 183 St OsAM 4370 vttt 053 054  stp05  veret

€. MEAN MOMTHLY DISCHARGE IH (U M/SECOND

VORI WR WA UKL RG S o0 ROV DK

1811 006 ¢ 002 0ol eol 142 103 281 043 032 0.55 008
"9?2 cnaee (AR X R [EENR] .llilt a0as c‘unoa sIdEE ecrase Tssks LR 22 L] LA RL X L EXY ]
973 005 004 002 001 0N 0.02 0.18 rZ I R R 335 1.64
w4 026 3 239 102 035 veeme vemee cemer meem 158 335 e
1915 - suses LTIy [ELIY] 0‘03 002 . 0'43 0.48 . 455 sresr misas sEssn

1?16 i:l'l' sits .!llll LA RS L] NYIEIT D LR LY dadte ‘i.lll dismdg sEsgEE AEdAE EESEI

-----

lq’] IIEREY g thany crxas Evrac “rans [EXZ RS otlitl . 434 ssasn sENs3 ER RN

*++4% INDICATES MISSING DATA, NOT INCLUDEQ IN CALCULATION OF STATISTICAL PiRAMETERS
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RIVER = BUCONG RIVER LOCATION = SALVADOR, CANOON,1L0COS SUR

STAIC = OISWITI202010 LATITUBE = 17 33 50

AGENCY = BPW.DPWH,BRS LONGITUDE = 120 28 50
DRAINAGE AREA (SO KM} = 49 ELEV OF Z GAGE = 12,04 M. ABDVE MSL

GAGE TYPE = NR OAGE OPERATION = STAFF GAGE READS IX A DAY
START OBSERVATION = APR1950  STATUS = NON-OPERATIONAL

0BS LAST CONSIDERED = DEC1927  REMARKS = 'RECOROS ARE FAIR

A. ANNUAE DISCHARGE CHARACTERISTICS (0 IN CU M/SEC)

YEAR P GAGEHT. DAE  TME  MAXDLY MEAX MINDLY GAGENT OMTE  RUNOFF
Q__ (Mg Q. _Q (Mo W
ETI Y I YT 1% T 7006 1% 005 088 AmD 12
19?2 oy 194t . . (ELLN J (AL EL] (A AR 2 LA Z RS . . (LRI L]
913 246 187 SEPR OBPM 047 ettt 000 043 fEBap e
199 924 202 AUG28 OMM 934 021 000 050 JAN26 1382
WIS 12825 295 AUG2E 07 18S0 233 000 0 IAN. 1433
W6 1940 301 AUGIZ OOM 10070 024 000 026 ARD 413
971800 212 AUG23 OMM S50 005 000 037 AR 32

(. MEAN MONTHLY DISCHARGE IN €U M/SECOND

YEAR JAN 1% MAR AR MAY  HUN Jut MG Si# 0(F _ NOY 0EC_
:g, 1971 on 032 005 003 003 08 176 . 416 098 L o 0.26

) l??? shd ke seud 1088 LE2 RN are s satde sEddd shdas Tads e L EX T Y] asgea samEs

1?13 «xfse [E2 2R} astes (X2 R L] : [E LR ] [ X RN ) LR R R 001 009 00' o'm LEX AN
1974 000 003 000 0.00 0 - 012 00! 113 046 ¢ 038 04 00
135 en 00 000 0.00 000 000 001 2434 23 048 026 . 001
16 000 000 000 00~ 000 000 0ol 01 04y om0l 000
197 000 000 000 - 000 . 000 000 001 031 004 001 000 000

+xe0 (NDICATES MISSING DATA, NOT IHCLUDED IH CALCULATION OF STATISTICAL PARAMETERS



RIVER = BUAYARIVER
STAID = CISWI70203PWO1H
AGENCY = BPW-DPWH, 8RS

LOCAT(ON
LATITUDE
LONGITUDE

= 17 06 42
« 120 30 18

» PALALISUR, STA. LUCIA, ILOCOS SUR

DRAINAGE AREA (S0 KM} = 185 ELEVOF ZGAGE = 7.03M.ABOVE MSL
GAGE TYPE = NR GAGE OPERATION = STAFF CAGE READS3X A DAY
START OBSERVATION = MAY 1848  STATUS = OPERATIONAL
OBS LAST CONSIDERED = KOV 1380  REMARKS = RECORDS ARE FAIR
A ANNUAL DISCHARGE CHARACTERISTICS (Q TH CU M/SEC)
YEAR MK GAGEHT. DAIE  TIME  MAXDIY HMEAN  MINBLY GAGEHT DAFE  RUNOFF
Q  (MHERS) Q Q Q_ (Maes M
B 4051 297 AUG-M 4350 153 028 L0 MARDY 24dss
Wi Msw 268 JULI4 23550 w004 013 0 103 MAY.0? 32500
W3 000 128 0C04 JAMK 2600 151 040 110 MAR- 2448
974 30800 256 OCL-05 OSPM 23600 *c*tt 040 110 MARJ2 ettt
1375 4500 210 JUR-22 O6AM 10730 446 040 110 MAY0 7217
1976 26880 248 JUN37 1INK 27260 944 O 085 NARO? 1530
1977 . 69300 340  SEP-22  C4AM SIBMT 1103 042 LII DECOL 1734
1978 047 - RI4  MAYI3 04 047 Ut 040 LI0 JAN. Ut
579 24600 - 240 - JULO4  OSAM - 19980 580 042 LI JAK. 938
1980 38400 270 NOY-O?© O4AM . 2 Ut 040 L0 MAR. et

B. EXTREMES OF DISCHARGE AND STATISTICAL PARAMETERS

" EXTREME DISCHARGE IN CMS -

MING =0.13

STATISYICS PEAK G MAXDLY O

MEANQ MINDLYQ

oot [NDICATES MISSING DATA, KOT INCEUDED IN CALCULATION OF STATISTICAL PARAMETERS

MAXQ = 693.00 MEAN FLW= 289245 = 213.848 9.530 0.345
DATE * =SEP22,1977 DATE =MAY(9,1972 STODEV = 202457 142.620 6428  0.101
GAGE H = 3.40 - GAGE K =1.03 SKEWNESS=  0.010 . -0.440 0.080  ~§.600
INSTANTANEOUS PEAK KURTOSIS = -2.284 - 2495 1.501 2.393
NO.YEARS = $0 0 - ? 10
(. MEAH MONTHLY DISCHARGE TN CU M/SECOND
YEAR AN 1] MAR AFR . MAY  JUN O JUL UG SEP 00 NGV BEC
¥ 04l 0y 035 033 033 103 4281 0 8308 MM B 44 047
1972 037 636 02 0.24 030 4076 1B 006 &N 5.18 0 6.50
1973 0.58 044 041 - 05! 0.4 043 LX) KR L 103 88 0% 643
1374 047 042 041 042 - 052 - §35 e, 2586 4086 8535 97 699
1978 058 0.48 0.44 043 . 047 DM 1295 415 59 13 1.9 0381
1976 045 . 043 . 043 042 093 5§63 RO 2408 - 050 943 042 o047
1977 042 042 - 041 040 - 310 4% 2% M0 st 85 052 042
]?78 040 0-40 . 0-40 0-40 0‘42 dasdsa (TN NTY] (XX 1] LT XL Y] [ X T Y aenwn 0.43
1979 042 045 042 042 MNP 09 1975 47 18 076 083 055
1980 tevt ettt 040 040 - 041 049 N 960 - 285 250 ;M vt
MEAN 047 042 033 040 081 1496 2075 3639 1896 1547 607 122
STOEY 010 004 005 006 085 1926 4068 2605 2668 22.30 966  2.16
SKEWSS 152 0.07 19896 6923 136 124 214 411 208 £84 133 108
KURTSS 148 €56 395 402 525 193 356 136 2713 480 216 559
NO.YRS 9 3 10 10 10 9 8 8 9 g 9 9



1.3 Socio-economic Conditions

3.3.2 Basic infrastructure

‘Table 3.3.1 Number of Elementary School, High School and Other Served Facilities

PROVINCIAL WATER SUPPLY, SEWERAGE AND SANITATION SECTOR PLAN

Content: Socio-evonomy - Services

Date: l!—‘agc: Tof |

| Filepame: socioals

[¥ata Collection Level : Municipal

Prov. No.: 0129

Shectnang: (M) Scivices

Region dumnber: 01

Proy. Name: 1locos Sur

Form Number: M 1S

NEDIA SERVICES
l_kﬂct‘s"r‘\.;ghiv Municipality E!f’ment.al}' Stchao! : High.School College Hospital Public Bank
o Public ' Private  Total | Poblic Private Total Morket
012901 |Akifen T 0 11 ] 0 1 0 0 0 0
012902 |Banayoyo 6 1] 6 ] 4] 1 0 0 0 i
012903  |Bamay ig o 18] o i 1 9 i I
012904 |Burgos 9 9 9 ! ) 2 o 0 v o
012905 {Cabugao 26 0 % ] } 2 0 2 ' ]
012966  |Candon 24 2 2% 4 ! s 1 2 ! 9
012907 {Cacaymn 4 0 g 2 0 2 0 I 0 0
0127908 |Cervantes i7 I 1% | i 2 o 1 i 0
012908 |Gufisnuyod 8 0 8 i A 2 0 T 0 0 1
012910 (G, ded Pilas 8 ) 8 0 ! | 0 o 0 )
012911 [Lidlidda 5 0 i 0 i 0 0 0 0
012912 [Magsingal 17 a 17 [ 2 3 0 . ] [
012913 [Nagbuket 8 0 8 I 0 1 i 0 0 0
012914 [Nasvacan 33 (O ¥ 4 2 6 0 I ! 2
012915 [Quirino 12 ! 13 ! 12 o o | 0
012916 ISaledo 15 0 15 |2 ! 1 0 1 | 0
012917 |5an Bitio 10 0 10 1 1 2 0 0 o o
012968 {San Estedan BT JRNRY S S 12 | 0 0. o {
0129i9  {San tidetfonso 4 0 4 1 o v | o |0 1 0
042920 fSan Juan w0 2| 3 1 a o ! ! 1
© 01292k |San Vicesie 50 5 o 1 i 0 i I .
012922 [Santa 10 0 10 2 ! | o o ! !
012823 [Sania Cataling 6 0 6 1 1 2 Q 0 0 1
012924 |Santa Cruz 22 0 22 2 1 6 0 0 i 3
012925 |Santa Lucia 14 0 14 3 2 s 0 i I 1
012926 |Sania Maria 19 0 19 I t 2 - ! I [
012927 |Santiogo 1 0 n | : -3 0 1 [
012928  |Sante Dainingo i) 0 20 2 ! 3 ] 1 I
012929 |Sigay a o 4 0 e 0 0 0 0 o
012030 |Sinait t7 0 17 I ) ' 0 | 1 ¢
032931 [Sugpon 8 0 3 I ) | 0 0 0 0
012932 |Suyo i3 o 18 I 0 P 0 0 ) !
01293}  |Tagedin i8 2 20 1 i 2 Q0 - { L
012934 |Vigan (Capitaly 72 a9 | i 4 2 8 ! l
[ Peovincial Total 355 9 464 | 45 3 1 s n 1y [ 40 |




M5 Health Status
A

5.8 Morbidity. Mortatity and Infant Mortality

Table 3.5.1 Morbidity, Morfality and Infant Mortality by Muoicipality (Annual incidence per 100,000 persons}

fCcatent Fealh - Mactidity and Mogtatity

!D e

“ﬁ‘uge Numnby P ef o

nl rata Collection Level: Municipal Regiot Nuriber: 04 tilepame: health.als .
ni'mv. Neo: 0129 Mun. Number: Not Applceble Sheetname: M) Morbidity and Martatity
uﬁ\ar, Name: Hoeos Sur Mun. Name: Not Appdiable Form Number: M 3.1
Number of Coses
Couse Group Diseases of: U'::w S:-me of Diseases {-Geoup} w :;:ﬁ:i:w Muorbiduy Monubiy Fedant Muogtality
[ Tlfective AOL |24 TypheilTarahy phoid x 08 1
g A2 5-1 Dyseatary X 21 ]
Purasith: A0 8-10¢ Tntestinal Parnsitism X 00
{ONE-136) A0 1-13/ Bisrrhea X S 5,69 -
A0S 14-16¢ Tubetculosis 1,403 20
A06 17-197 Conjunctivities X 91
A 07 20-22/ Whooping Cough 8
A0S 23-25 Throat/Ear/Nose 27
AD% 26-28/ Tetanus 53 9
AD 219-3 Septicemia 2 2
Al 32-M7 Cholera X 12
A2 35-1% Varicella, Chickenpox 111
Al 184 Meusles 124 2
Ald 41-43 Dengue Fever X 12
AlS 14-460 Viral Heputitis X 52 1
Ald 4749 Malaris X 9 2
Al? 50-527 Schistosonviasis X
AR 53-85/ Filariasis X ] 6
A9 56-587 Veacrial Diseases 1
A 2D 52-61/ Oiber Bacterd Viesl Bis. 21
Newoplasnis 8.04 62-61/ Malignant Neoplasms 40 a5 : _
(130239 B.O2 63-67f Leukemia i0 8 )
Endoxiine. Nuttitional C.0l 68-70/ Drinbetes Meltitus 12 3
& Metabollid 02 T1-23 Nutnmionat Pefioencies | 5} 16
(250-279) CO03 74-T64 Endocrine Disorder 20 - 2
Blocd & B"’z‘f(:;;';;’“g DENS |5 0)  [27-797 Aneming 20 6
Mentat Disorder (290-39) E.Di Meatal Discrder
Neevous System F.01 SO-8 Meningitis - 13
& Sense Organs {120-18%) F.02 83-85/ Neevous Systein 9 : 2 _
- Circelatory Gol B6-B8/ Jeant Diseases 0,243 41
Systems (390-45%) -G OY 0 {89-9% Vascular Diseases 162 : 1 ]
Ol 92-94f Bronchitis 1502
Respiratory i1.02 95-9% Paeumoiia b 305 34
Kystems HO Q8- 1000 Faflucnza L1 2
00519 HOd [Q1-10% Obstruciine Putmonary 19 4
H 038 104-106/ ART 71 2
Digestive 101 L07-LOS/ Appeadicitis 69
Systemm 102 P11 1Y Gastroent. Colitis X 15
(520-574; 103 B33 ES/ Cheonic Liver Disense | £
. (143 b6 3 EBF Onhed Diges. Diseases 0
- . Genito-Urinary 101 }§9-3 21/ Kidney! Nephiitis 50
Syster (SE-629) 102 §22-3 244 Urinary Infections 91 4 |
U"P[":‘:;\'{‘l:::';g‘(';’;: g)&_‘he KO - |25 120 Pecwmaturiy n 10
Skin & Subcatancous Lol 1 23-D 00/ Skin Diseases X 46 A
Tissue (B80-709) o2 " [133-13% Scebies X i ]
¥ (M0t [134-136¢ Artheop Rhoumarisn 156
Coagenitul Anomalics (740-259) IN.O1 1371-138/ Congenilal Anomahes 30 M
POL. 140-14Y Birih Travma il i
Certaiil t‘nu&gs .o! Pecaatal o2 143-145/ Birth Injurics & Dilficuk 0 3
Muorbidity Lt T
ad Monalay rol F46- 1484 Resp. Felus/Newborn 51 38
(160-179) P4 159-151 Onher Frenadal Causes a 1
5y wptoms & Q0L 152154/ Semlity 0
Accidents. Proisoning RM 158- 160/ Burns 16 N
& Viclence g.02 161-16Y Sufioc. Foreign Body 9 _ i
(S0-999; 203 164- 1664 Other Accidents 187 24 ]




3.5.3 llealth Factlitics and Practitioners

Table 3.5.2 Number of Hecalth Facilities and Practitioners by Municipality

Content: Health - Facility and Practitionee | Date: i!’agc No. lof1 II’ilemmc: health,xls
Data Collection Level: Municipal Peov. No. : 0129 1Shmame: (M)FacilityPractioner
Region Nupmber: 01 Prov. Nante: Noves Sur IFc-rm No, ;M2
NEDA _ Numbee of Facilities Number of Medical Practionens
Geographic Name
“Coude Hospital| RHU BHS Doctors Nurses Midwives Dentists
12601 Afilem o 1 3 1 [ 3 0
12902 Banayoyuo o 1 3 | ! 2 i
12903 |Rantay 1 1 5 9 2 i3 4
12001 |Burgos 0 i 2 } I 5 2
12905 Cabugao 2. | 7 11 12 15 7
12906 |Candon 2 1 9 24 g 18 ks
12907 Caoayan -0 i 5 3 ] 4 i
12908  [Cervantes ! i 8 3 3 b 1
12909  {Galimuyod 0 1 4 L4 I 5 2.
12910 |G, del Pilar 0 t 3 1 1 3 0
J2911  Lidkidda 0 ! 7 ! i 2 -0
12912 |Magsingal ] P 5 5 3 15 6
12913 |Nagbukel 0 P 2 1 1 2 0
12914~ [Narvacan 1 I 21 14 17 8
12915 |Quisino 0 1 4 0 b 4 0
12916, |Satcedo ! 1 3 3 4 K ]
12917 |San Emilio 0 I 3 0 ! 3 x)
12918 |San Esteban 0 | 3 2 1 I i
12919 - [Sanildelfonso | O 1 3 l 1 13 U
12920 [San Juan 9 1 5 10 4 14 1
12921 |Son Vieente ! ! 4 3 i aEN 4
p2922 |Santa 1) | 4 ) 1 6 0
12921 |Santa Catalina 0 l 3 i i 13 6
12924 Santa Cruz 0 ) 6 4 i 13 3
12925.  {SantaLucia 1 ] i 7 g 10 2
12926  {Santa Maria b 1 7 10 1 17 6
12927 [Santiago 0 I 5 1 ] o 4
12028 |Santo Domingo | 0 \ 5 6 1 15 7
12920 |Sigay o I 2 I 0 3
12930 |Sinait | I 6. 5 12 16 0
12931 |Sugpon 0 1 2 1 i : T
12932 [Suyo 0 | 4 | 1 4 t]
12933 Tagudin i 1 6 9 5 7 3
| 12934 jVigan(Capital) 8 | 1 4} 73 23 16
Provingal Total 2 | M | aw 206 189 305 107
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nvirenmental Condit
3.6.3 Solid Waste Disposal
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XISTING FAC

Sanitation and Sewerage
4.2.3 Sanitation Facitities and Service Coverage
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